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Prologo

Faxitron Bioptics, LLC ha elaborado este manual. Tiene el objetivo de guiar al usuario avanzado durante la configuracion,
la instalacion y el uso del hardware Faxitron Core, asi como del sistema de software Vision, ambos desarrollados por Faxitron
Bioptics, LLC.

El usuario debera configurar primero el hardware y, a continuacion, iniciar el software Vision de Faxitron. Antes de continuar,
revise los procedimientos de configuracion obligatorios incluidos en la Seccion 4 de este manual.

Indicaciones de uso

El sistema de radiografia digital de especimenes (DSR) Faxitron Core es un sistema de obtencidn de imagenes digitales
de rayos X que esté alojado en un armario y esté destinado a generar y controlar rayos X para examinar varias regiones
anatémicas, asi como para verificar rapidamente que se haya extirpado el tejido correcto durante la biopsia percutanea.
Realizar directamente la verificacion en la misma sala de biopsias permite que los casos se concluyan mas rapidamente,
limitando asi el tiempo necesario para explorar al paciente. La radiografia de los especimenes puede limitar potencialmente
el nimero de citas para los pacientes. Este dispositivo esta destinado a utilizarse en todos aquellos lugares que los
profesionales médicos consideren pertinentes, como areas quirlrgicas o estancias adyacentes a las areas quirargicas.
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SECCION

Introduccién
y simbolos

Faxitron Bioptics, LLC ha elaborado este manual. Tiene el objetivo de guiar al usuario durante
la configuracion, la instalacion y el uso del hardware Faxitron Core, asi como del sistema de
software Vision, ambos desarrollados por Faxitron Bioptics, LLC.

El usuario debera configurar primero el hardware y, a continuacion, iniciar el software Vision
de. Antes de intentar utilizar el sistema, repase en este manual, como minimo, los
procedimientos de configuracion y seguridad obligatorios.

Gracias de parte de todos los que formamos parte de Faxitron Bioptics, LLC.
Informacidén adicional
Si desea obtener mas informacién, péngase en contacto con nosotros:

Faxitron Bioptics, LLC (a Hologic company) Representante autorizado en Europa

3440 E. Britannia Dr. Suite# 150 (de lainformacién normativa)
Tucson, AZ 85706 Hologic BVBA
+1 (877) 910-0030 Da Vincilaan 5
(520) 399-8182 Fax 1930 Zaventem
www.hologic.com Bélgica
Tel.: +32 2 711 46 80
Fax: +32 2 725 20 87 C E

1.0.0
Introduccion

En este manual y en el sistema de ayuda en linea, se utilizan los siguientes simbolos:

Advierte al lector de una posible electrocucion en caso de que ignore la
advertencia y utilice deliberadamente herramientas especificas para abrir un
armario eléctrico precintado y manipular su contenido. Nota: Faxitron Bioptics,
LLC no proporciona ninguna herramienta.

acompafiado de un simbolo mas especifico y de las instrucciones pertinentes en
cuanto a la naturaleza del peligro, el resultado esperado del peligro y la
informacion para evitarlo.

Advierte al lector de que debe tener cuidado al levantar equipos pesados para
evitar generar lesiones corporales y dafios al equipo.

2>

Advierte al lector de una situacion de peligro. Por lo general, este simbolo va f

cuando el haz de rayos X esta bajo tension. El sistema Faxitron Core dispone de
enclavamientos de seguridad que evitan que se acceda a la zona etiquetada
mientras el haz de rayos X esta bajo tension.

Advierte al lector que utilice la proteccion adecuada (como guantes quirlirgicos o
un recipiente autorizado para especimenes) con el fin de evitar la exposicion a
materiales potencialmente infecciosos, como las muestras de tejidos del paciente.

Advierte al lector de que en el area etiquetada se emite una radiacién ionizada '

o>

1.1.0
Simbolos de
advertenciay
precaucion
incluidos en
este manual
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SECCION
Proteccion
radiologica y
rayos X

La radiacién es energia en forma de ondas o particulas. La radiacion de alta frecuencia y alta 2.0.0

energia, que tiene suficiente energia para desplazar un electrén de su 6rbita alrededor de un .,
nucleo, se denomina radiacién ionizante. Los rayos X, los rayos gamma, las particulas beta, Introduccion
las particulas alfa y los neutrones son todas formas de radiacion ionizante y pueden ser

emitidos por material radioactivo, estrellas y equipos de alto voltaje.

No podemos ver, sentir, saborear, oler ni oir la radiacién ionizante, por lo que para detectarla,
es necesario tener un equipo de vigilancia.

2.1.0

Rayos X
Rayos X

Los rayos X son radiaciones de alta frecuencia y alta energia que tienen suficiente energia para
desplazar a un electron de su orbita alrededor de un nucleo y se denominan radiaciones
«ionizantes». Los rayos X son capaces de viajar largas distancias atravesando el aire y la
mayoria de los demas materiales. La cantidad de energia transportada por la radiacion es
directamente proporcional a la frecuencia e inversamente proporcional a la longitud de onda.
Los rayos X tienen una longitud de onda relativamente corta, asi como alta frecuencia, por lo
que poseen una gran cantidad de energia.

Los rayos X pueden producir cambios bioldgicos en el tejido, que pueden ser beneficiosos
cuando se utilizan en radioterapia. Sin embargo, los rayos X también pueden ser nocivos para
los organismos biolégicos, debido a su capacidad para dafar los cromosomas.

En los centros médicos, las fuentes de radiacion de rayos X incluyen:

Maquinas de rayos X. Las maquinas de rayos X se utilizan con fines terapéuticos (radioterapia)
y diagndsticos. Las maquinas diagndsticas de rayos X se utilizan para radiografiar varias partes
anatémicas (torax, piernas, senos, etc.), con fines diagndsticos. Hoy en dia, solamente en los
Estados Unidos, la radiologia diagndstica representa dos tercios de la cantidad de sus recursos
artificiales. Las maquinas de rayos X pueden producir altos niveles de radiacion ionizante.

Maquinas de rayos X de armario. Las maquinas de rayos X de armario son compartimentos de
irradiacion que estan encapsulados, protegidos y asegurados con enclavamientos. La maquina
solamente puede funcionar cuando la puerta del compartimento esta bien cerrada. Las tasas de
exposicién en cada lugar del exterior cumplen la tasa especificada para las areas no controladas.

Fuentes de radiacion 2.2.0

Todos estamos expuestos diariamente a la radiacion. Segun la Comisién Nacional de Fuentes de
Proteccién Radiolégica (NCRP, National Council on Radiation Protection), la dosis media de radiacién
fondo en los Estados Unidos es de 360 mrem/afio (3,6 mSv/afio). Estas exposiciones

provienen en su mayoria de fuentes naturales de radiacion, como el radon, la radiacion cosmica

y los depdsitos naturales terrestres. jIncluso nuestros cuerpos contienen radiactividad natural!

Existen 2 fuentes de radiacién: natural y artificial.

Las fuentes naturales de radiacion incluyen los rayos cosmicos, los rayos gamma terrestres, los
radionuclidos del cuerpo, asi como el radén y sus productos de descomposicion. Se estima que la
dosis efectiva anual media mundial procedente de fuentes naturales es de 2,4 mSv (240 mrem).
Hay factores que afectan a las dosis efectivas de estas fuentes naturales de radiacion: la tasa de
dosis de rayos césmicos depende de la altura sobre el nivel del mar y la latitud; la tasa de dosis de
rayos gamma terrestres depende de la geologia local; y la dosis de productos de descomposicion
del raddn depende de la geologia local, asi como de la construccion y el uso de las viviendas.
Consulte en la tabla 1 las dosis efectivas anuales de estas fuentes naturales.

Tabla 1
Dosis efectiva anual a adultos, procedente de fuentes naturales

. Dosis efectiva anual (mSv)
Fuente de exposicion — =
Tipica Elevada
Rayos césmicos 0,39 2,0
Rayos gamma terrestres 0,46 4,3
Radionuclidos del cuerpo (excepto el radén) 0,23 0,6
Radon y sus productos de descomposicion 1,3 10
TOTAL (redondeado) 24 -

*Los valores elevados son representativos de las grandes regiones. Incluso los valores mas
altos se producen a nivel local.
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SECCION
Proteccion
radiologica y
rayos X

Los rayos X médicos son una fuente importante de radiacién artificial. Los rayos X médicos
utilizan radiacion ionizante tanto para el diagndstico como para el tratamiento de lesiones y
enfermedades. UNSCEAR (Comité Cientifico de las Naciones Unidas para el Estudio de los
Efectos de la Radiacion Atémica) estima que la exposicion individual a la radiacién médica
oscila entre 0,4 y 1 mSv al afio. La exposicion a la radiacion médica excede a la de todas las
demas fuentes artificiales, pero representa menos de la mitad de la exposicion a la radiacion
natural de fondo.

Las dosis de radiacion ionizante utilizadas en los rayos X de diagnéstico suelen ser bastante
bajas, < 50 keV.

La siguiente tabla muestra las contribuciones procedentes de varias fuentes de radiacion.

Espacio
(fondo)
Interno (5 %)
(fondo)
(5 %)
Terrestre
(fondo)
(3 %)

Radon y toron
(fondo) (37 %)

Tomografia
computarizada,
{médica)
(24 %)

Industrial (= 0,1 %)
Profesional (= 0,1 %)
Consumidor (2 %)

Radiografia/flucroscopia

Medicina nuclear T Sh
convencional {medica)

(médica) (12 %)

Fluoroscopia
intervencionista (3 %)
(médica) (7 %)

Al provocar cambios en los atomos y las moléculas, la exposicién a las radiaciones ionizantes
puede tener efectos nocivos para la salud. Cuando la radiacién ionizante atraviesa el tejido, se
transfieren grandes cantidades de energia a moléculas individuales. Esta transferencia de
energia hace que los electrones se desprendan de los atomos, y que se inicie una serie de
efectos quimicos y fisicos. El mas critico de estos efectos es el dafio a las moléculas de ADN.
El cuerpo tiene mecanismos que normalmente reparan este dano, pero es posible que no se
reparen dafos extensos o de determinado tipo. Cuando el cuerpo es incapaz de reparar el
dafo, la célula puede morir o mutar. Las células mutadas tienen el potencial de convertirse en
canceres. La extension del dafio es proporcional a la energia transmitida o a la dosis de
radiacion ionizante recibida.

Los efectos de la exposicion a la radiacion de rayos X sobre la salud se presentan en dos tipos
generales: directos o indirectos. Se cree que los rayos X crean radicales en las células
expuestas del cuerpo, que pueden romper o modificar los enlaces quimicos dentro de las
moléculas biolégicas criticas.

2.2.0 Cont.

Figura 2.2.1
Fuentes de la dosis
de radiacion en los
Estados Unidos.

De NCRP 160, Fig. 1.1.
Contribucion porcentual de
diversas fuentes de exposicion
a la dosis efectiva colectiva total
(1870 000 personas-Sv) y a la
dosis efectiva total por individuo
en la poblacién de los Estados
Unidos.

2.3.0
Efectos bioldgicos
de la radiacion
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SECCION

Proteccion
radiologica y
rayos X
Como resultado 2.3.0 Cont.
(1) las células pueden lesionarse o dafiarse, aunque muchas células se reparan por si
mismas, lo que no genera ningun dafio residual;
(2) las células pueden morir, lo que hacen millones de células del cuerpo cada dia, y son
reemplazadas durante un proceso biolégico normal;
(3) o las células pueden repararse incorrectamente y provocar un cambio biofisico. Para
terminar, los rayos X pueden atravesar el cuerpo sin ninguna interaccion.
El dafio provocado a las células por la radiacion ionizante puede generar:
e La produccion de radicales libres
e Larotura de los enlaces quimicos
e La produccion de nuevos enlaces quimicos y la reticulacion entre macromoléculas
e Darios alas moléculas que regulan los procesos celulares vitales (por ejemplo, ADN, ARN,
proteinas)
La tasa de la dosis, la dosis total recibida, la energia de la radiacion, el area anatomica
expuesta, la sensibilidad del individuo y la sensibilidad celular son todos factores que
determinan los efectos bioldgicos de la exposicién a la radiacion.
Existen dos tipos de efectos de la exposicion a la radiacién ionizante: efectos deterministicos
y efectos estocasticos.
2.3.1
EFECTOS DETERMINISTICOS Y ESTOCASTICOS Efectos

Los efectos biolégicos potenciales dependen de la cantidad y la rapidez con la que se reciba deterministicos
una dosis de radiacion. Las dosis de radiacién se pueden agrupar en dos categorias: dosis y estocasticos
agudas y dosis cronicas.

Dosis aguda y efectos deterministicos

La exposicion aguda a la radiacion es una dosis alta de radiacién que tiene lugar durante un
periodo corto de tiempo, normalmente de segundos a dias. Los efectos causados por las dosis
agudas de radiaciéon se denominan deterministicos; la gravedad del efecto esta determinada
por la cantidad de dosis recibida. Los efectos deterministicos suelen tener algun nivel de
umbral, por debajo del cual es probable que el efecto no se produzca, pero por encima del cual
se espera que se produzca. Por encima del umbral, /a gravedad del efecto aumenta a medida
que aumenta la dosis.

Por ejemplo, una dosis en todo el cuerpo de aproximadamente 300 rems (3 Sv), 60 veces el
limite de la dosis profesional anual, si se recibe dentro de un periodo de tiempo corto (por
ejemplo, unas pocas horas) causara vomitos y diarrea a las pocas horas; pérdida de cabello,
fiebre y pérdida de peso a las pocas semanas; y alrededor de un 50 por ciento de
probabilidades de muerte sin tratamiento médico. Estos efectos no se producirian si la dosis
de 300 rems (3 Sv) se acumulara gradualmente durante muchos afos.

También existe una diferencia entre las exposiciones anatdmicas totales y parciales. Cuando
una dosis aguda de 600 rem (6 Sv) en la mano causara enrojecimiento de la piel, la
recuperacion se produciria en los meses siguientes y no se esperaria ningun dafio a largo
plazo. Sin embargo, una dosis aguda de esa magnitud en todo el cuerpo podria causar la
muerte en poco tiempo sin tratamiento médico.

La utilizacion de mecanismos adecuados de proteccion radioldgica y de limites de dosis de
exposicion profesional reducen la probabilidad de que se produzcan estos efectos.

Los limites de dosis profesionales estan muy por debajo de los umbrales de los efectos
deterministicos.
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Dosis crénica y efectos estocasticos

Una dosis cronica es una cantidad relativamente pequefia de radiacién recibida durante un
periodo de tiempo prolongado (por ejemplo, afios). El cuerpo esta mejor equipado para tolerar
una dosis crénica que una dosis aguda, ya que tiene tiempo para reparar el dafio porque, en
un momento dado, un porcentaje mas pequefo de las células necesita reparacion. El cuerpo
también tiene tiempo para sustituir las células muertas o que no funcionan por células nuevas
y sanas. Sin embargo, esto no significa que no haya ningun riesgo relacionado con la
exposicion crénica a la radiacion.

El término estocastico significa «aleatorio», con la implicacién de que no es seguro que los bajos
niveles de exposicion a la radiacién produzcan un efecto. Estos niveles bajos, por debajo del
umbral de los efectos deterministicos, pueden o no generar efectos perjudiciales para el cuerpo.

Sin embargo, tenga en cuenta que:

1)No existe un umbral de exposicidon a la radiacion por debajo del cual podamos decir con
certeza que los efectos no se produciran.

2)Duplicar la dosis de radiacion duplica la probabilidad de que se produzcan los efectos.

La exposicion cronica puede producir efectos que solamente pueden ser observados cierto
tiempo después de la exposicion inicial. Estos pueden incluir efectos genéticos y otros efectos,
como cancer, lesiones precancerosas, tumores benignos, cataratas, cambios en la piel y defectos
congénitos. Generalmente, la mayor preocupacion es el desarrollo de algun tipo de cancer.

No se observan efectos inmediatos por debajo de las dosis de 25 rem (0,25 Sieverts). Los
efectos latentes pueden aparecer afos después de recibir una dosis. Mediante estudios
realizados en poblaciones expuestas a la radiacion ionizante (> 0,5 Sv) se ha encontrado que
la probabilidad de que se presente un cancer mortal por exposicién a la radiacién es del 5 por
ciento por Sv aproximadamente.

RADIOSENSIBILIDAD

La radiosensibilidad es la probabilidad de que una célula, tejido u 6rgano sufra un efecto por
unidad de dosis de radiacion. La radiosensibilidad es mas alta en las células que se dividen
rapidamente (altamente mitéticas) o que relativamente no estan especializadas
(indiferenciadas). Por esta razén, la epidermis basal, la médula 6sea, el timo, las génadas y las
células del cristalino son altamente sensibles a la radiacion. Los tejidos musculares, 6seos y
del sistema nervioso tienen una radiosensibilidad relativamente baja. Ademas, la
radiosensibilidad es mayor durante la etapa fetal y se reduce progresivamente a lo largo de la
adolescencia y la edad adulta.

Ley basica de la radiobiologia: los efectos bioldgicos son directamente proporcionales al indice
mitoético y al futuro mitético de la célula expuesta, e inversamente proporcionales al grado de
diferenciacion. La mitosis se refiere a la division natural del nucleo celular durante la
reproduccion celular; la diferenciacion se refiere al grado de especializacion de la célula para
realizar una funcion especifica en un organismo.

RIESGOS DERIVADOS DE LA EXPOSICION A LA RADIACION

Se estima que aproximadamente el 20 % (1 de cada 5) de todas las muertes producidas en los
Estados Unidos se debe a algun tipo de cancer.

Si cada miembro de una poblaciéon de 1 millén recibiera 10 mrem (0,1 mSv) de radiacion, es
posible que se observaran 5 muertes adicionales. Recuerde que, de esta poblacién de 1 milldn,
cerca de 200 000 moriran de cancer, lo que hace que estas pocas muertes adicionales sean
estadisticamente imposibles de detectar.

2.3.1 Cont.

2.3.2
Radiosensibilidad

2.3.3

Riesgos derivados
de la exposicion a
la radiacién
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Ademas, el riesgo de muerte por cancer es del 0,08 % por rem (10 mSv) para las dosis
recibidas rapidamente (agudas) y puede ser 2 veces (0,04 %, o 4 de cada 10 000) menor que
para las dosis recibidas durante un periodo de tiempo prolongado (crénicas).

A partir de los datos actualmente disponibles, la Comisiéon Reguladora Nuclear de Estados
Unidos (NRC, Nuclear Regulatory Comission) ha adoptado el valor de riesgo de una dosis
profesional en 1 rem (0,01 Sv), que representa un riesgo de 4 de cada 10 000 de desarrollar
un cancer mortal.

La Comision Internacional de Proteccion Radioldgica (publicacion 103, 2007) indica un valor
del 5,5 % por sievert para el cancer y del 0,2 % por sievert para los efectos hereditarios tras la
exposicion a la radiacion a baja tasa de dosis.

El riesgo asociado a los usos diagndsticos de la radiacion ionizante se limita normalmente a
los efectos estocasticos tardios, que se estima que ocurren con una frecuencia de, tal vez, el
0,01 % para un examen promedio (en casos extremos, pueden producirse dafios
deterministicos en la piel tras una fluoroscopia). A nivel individual, estos riesgos son casi
siempre pequefios, comparados con el beneficio del diagndstico y el tratamiento.

CONCLUSIONES SOBRE LOS RIESGOS PARA LA SALUD

Asumimos que cualquier exposicion a la radiacion, por pequefia que sea, conlleva algun riesgo.
Sin embargo, sabemos que, por término medio, estos riesgos son comparables o menores que
los riesgos que encontramos en otras actividades u ocupaciones que consideramos seguras.
Dado que tenemos un amplio control sobre la cantidad de exposiciéon a la radiacion que
recibimos en el trabajo, controlamos y minimizamos este riesgo. El mejor enfoque es mantener
nuestra dosis tan baja como sea razonablemente posible, o ALARA, término que discutiremos
en detalle mas adelante. Minimizar la dosis minimiza el riesgo.

LIMITES DE LA DOSIS MARCADOS POR LA CIPR

La Comision Internacional de Proteccion Radiolégica (CIPR) ha establecido limites de dosis de
radiacion basados en los datos disponibles. Estos limites de dosis son valores maximos
permitidos para las exposiciones anatomicas totales. La unidad de medida de la dosis se llama
Sievert (Sv), que tiene en cuenta varios factores de determinacion de una cantidad llamada
dosis efectiva. Los limites de la dosis se actualizaron por ultima vez en 2007.

Para el publico en general, el limite de la dosis es de 1 mSv/afio (0,001 Sieverts por afio)

Para los trabajadores profesionales (los que trabajan en la industria nuclear), el limite de la
dosis es de 20 mSv/afio (0,02 Sieverts por afio)

Los limites de la dosis excluyen los efectos de la radiacion de fondo.

Limites de dosis anuales recomendados por la CIPR para érganos independientes o tejidos

Dosis ponderada por radiacion en Trabajadores Publico
Cristalino 150 mSv 15 mSv
Piel 12 500 mSv 50 mSv
Manos y pies 500 mSv -

1. La limitacion de la dosis efectiva proporciona suficiente proteccion para la piel contra los
efectos estocasticos. Con el fin de prevenir las reacciones de los tejidos, se necesita un
limite adicional para las exposiciones localizadas.

2. Promedio de mas de 1 cm2 de area de piel independientemente del area expuesta.

2.3.3 Cont.

234
Conclusiones
sobre los riesgos
para la salud

24.0

Limites de la dosis
marcados por la
CIPR
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Factores determinantes

Los efectos de la exposicion a los rayos X dependen de la duracion de la exposicion, de la
rapidez con la que se administre la dosis, de la energia (cuanta energia habia en el rayo X), de
la dosis total (de la magnitud de la dosis) y de si la exposicion es de cuerpo entero o localizada.
Los rayos X de baja energia (< 50 KeV) pueden provocar dafios solamente en la piel o a la
parte externa del cuerpo, mientras que los rayos de alta energia pueden penetrar en el cuerpo
hasta llegar a los érganos internos. Una dosis aguda y creativa que se administre de una vez
tendria un efecto mayor que la misma dosis administrada a lo largo del tiempo en fracciones
incrementales.

En los entornos sanitarios, el riesgo de exposicion a la radiaciéon puede minimizarse:

e Evitando todas las exposiciones innecesarias a la radiacion

e Empleando dosis que sean tan bajas como razonablemente alcanzables (ALARA)

e Siguiendo las instrucciones de uso del fabricante del equipo

e Siguiendo las instrucciones de mantenimiento preventivo de los fabricantes del equipo
e Utilizando un blindaje apropiado

ALARA

El concepto ALARA se basa en el supuesto de que cualquier dosis de radiacién, por pequefia
que sea, puede tener algun efecto adverso. En virtud del ALARA, se utilizan todos los medios
razonables para reducir la exposicion.

Para reducir la exposicion de una persona a cualquier tipo de radiacion ionizante, existen tres
reglas generales.
1. Reducir el tiempo de exposicion a la fuente de radiacion.
e Al reducirse el tiempo de exposicion, se reduce la dosis de radiacion.
2. Aumentar la distancia entre usted y la fuente de radiacion.

e El aumento de la distancia de una fuente de radiacién reduce significativamente
la dosis de radiacion.

e Duplicar la distancia de una fuente de radiacién supone reducir la dosis a una
cuarta parte.

e Triplicando la distancia se obtiene una novena parte de la tasa.
3. Aumentar el blindaje entre usted y la fuente de radiacion.
e El uso de un blindaje adecuado reduce enormemente la dosis.
e El material utilizado y el espesor del blindaje dependen de la fuente de la radiacion.
e El plomo es un material comun de blindaje.

Consulte al responsable de Proteccion radioldgica las reglas y directrices especificas de su
centro de trabajo.

2.5.0
Gestiodn de riesgos
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El sistema de radiografia digital de especimenes (DSR) Faxitron Core es un sistema 3.0.0
compacto de armario para escritorio de obtencién de imagenes digitales de rayos X destinado T,
a verificar rapidamente las biopsias core. Descri pcion
o o : o . general
Realizar directamente la verificacion en la misma sala de biopsias permite que los casos se
concluyan mas rapidamente, limitando asi el tiempo necesario para explorar al paciente. La
radiografia de los especimenes puede limitar potencialmente el nUmero de citas para los
pacientes. El pequefio tamafio de Faxitron Core permite su instalacion en areas quirdrgicas u
oficinas con espacio limitado.

El sistema de radiografia digital de especimenes Faxitron Core utiliza Vision, un potente y
completo software de adquisicion de imagenes y manipulacién de datos. El software Vision
gestiona la obtencion digital de las imagenes de rayos X, la calibracion, la visualizacion de las
imagenes, el andlisis y la manipulacién de las imagenes, la base de datos de los pacientes, el
archivo de las imagenes y la transmision. El software Vision constituye la parte central de este
sistema. El software Vision es compatible con el estdndar DICOM (Imagenologia Digital y
Comunicaciones en Medicina) 3.0 y dispone de impresién, almacenamiento y una lista de
trabajo de modalidad (MWL) DICOM.

Version de DICOM 3.0.1
Faxitron utiliza el Gltimo estandar DICOM: Version de DICOM
Imagenologia Digital y Comunicaciones en Medicina (DICOM) v3.0, desarrollado por ACR-

NEMA, version definitiva, agosto de 1993

Y cumple el estandar:
NEMA PS 3.1-3.20 (2016), Equipo de Imagenologia Digital y Comunicaciones en Medicina

Clases de almacenamiento

Faxitron DR cumple la norma relativa a la siguiente clase SOP (par servicio-objeto) de
DICOM V3.0 como SCU (usuario de clase de servicio).

Clase SOP como SCU

Clase SOP UID (identificador Unico)
de clase SOP

SOP de almacenamiento de imagenes de radiografias 1.2.840.10008.5.1.4.1.1.1

computarizadas

Presentacion del almacenamiento digital de imagenes 1.2.840.10008.5.1.4.1.1.1.1
realizadas con rayos X

Procesamiento de imagenes digitales realizadas con 1.2.840.10008.5.1.4.1.1.1.1.1
rayos X

Presentacién del almacenamiento de imagenes digitales |1.2.840.10008.5.1.4.1.1.1.2
de mamografias realizadas con rayos X

Procesamiento de imagenes digitales de mamografias 1.2.840.10008.5.1.4.1.1.1.2.1
realizadas con rayos X

Consulta o recuperacion de la informacién raiz del 1.2.840.10008.5.1.4.1.2.2.1
estudio. Modelo -FIND
Consulta o recuperacion de la informacion raiz del 1.2.840.10008.5.1.4.1.2.1.1

paciente. Modelo -FIND

Modelo -FIND de informacion de las listas de trabajo de |1.2.840.10008.5.1.4.31
las modalidades

Almacenamiento de la presentacion de las copias 1.2.840.10008.5.1.4.1.1.11.1
digitales en escala de grises

Para conocer mas detalles, consulte en su totalidad la Declaracién de Conformidad de
DICOM, que esta almacenada en el sistema. El archivo esta en C:\Faxitron, y hay un acceso
directo en el escritorio.

Si la necesita, puede solicitar a Faxitron una copia de la Declaracién de Conformidad de DICOM.
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Mantenimiento

En los equipos Faxitron no hay piezas que se puedan reparar. Para recibir asistencia técnica,
pongase en contacto con el representante autorizado de Faxitron.

Faxitron Bioptics, LLC

3440 E. Britannia Drive, Suite 150
Tucson, AZ 85706

EE. UU.

Tel.: (520) 399-8180

Fax: (520) 399-8182

Correo electrénico: support@faxitron.com

Sitio web: www.hologic.com

Solucién de problemas

Consulte el Manual técnico de Faxitron Core; péngase en contacto con el representante de
Faxitron o con el servicio de atencion al cliente de Faxitron.

PROGRAMA DE MANTENIMIENTO

Consulte el Manual técnico de Faxitron Core; péngase en contacto con el representante de
Faxitron o con el servicio de atencion al cliente de Faxitron.

3.0.2
Mantenimiento
y resolucion de
problemas

3.0.3
Programa de
mantenimiento
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DISTANCIAS entre la FUENTE y el GENERADOR DE IMAGENES (SID) y entre la FUENTE
y el OBJETO (SOD):

Desde la parte superior de la camara hasta el generador de imagenes:

5,8 mm (0,230 pulgadas)

Desde el blanco del tubo hasta el generador de imagenes:

327,66 mm (12,90 pulgadas)

Desde el blanco del tubo hasta la posicion de la muestra:  8,94: (227,08 mm)
Desde el generador de imagenes hasta la posicion de la muestra:

100,58 mm (3,96 pulgadas)

Ampliacion efectiva:  1,44:1

PESO: 18 kg (40 libras)

REQUISITOS DE POTENCIA:
maximo de 120 V CA, 60 Hz, 150 W o maximo de 230 V CA, 50 Hz, 150 W

POTENCIA CALORIFICA: maximo de 500 BTU/h

CICLO DE TRABAJO DE LOS RAYOS X: 50 %

CONTROL DE LA EXPOSICION: automético o manual

3.1.0
Especificaciones

Figura 3.0.1
Dimensiones y peso
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Requisitos | Cumplimiento de Faxitron Core 3.2.0

El centro o la institucién que utilice este sistema sera responsable de asegurar que se cumplan Req uisitos de
todas las normativas locales, regionales y federales que afecten al uso de equipos de radiacion cum p| imiento

ionizante. .
y medidas de
seguridad

Limites de emisién

La radiacion de rayos X emitida por la unidad Faxitron Core no excede una exposicion de 0,3

mili-Roentgens (mR) por hora en cualquier punto a 5 centimetros (cm) fuera de la superficie

externa. Para los paises que exigen valores de emisién medidos a 10 cm de la superficie

exterior, la radiacion no supera los 0,1 mR por hora a 10 cm.

Enclavamientos de seguridad

El sistema Faxitron Core de radiografias digitales de especimenes tiene dos enclavamientos

de seguridad en el cajon de especimenes, el panel de acceso frontal y la cubierta trasera

para evitar la generacion de rayos X, a menos que estén cerrados o instalados.

Botdn Start (Inicio)

Tras la interrupcién de la generacion de rayos X por los enclavamientos de seguridad, el

botén Start (Inicio) del panel frontal reanudara la generacion de rayos X cuando esté listo.

Control accionado por llave

El interruptor de cerradura con llave situado en el panel frontal requiere que se inserte y se

gire una llave en el sentido de las agujas del reloj hasta la posicion de las 3 para suministrar

energia al sistema de armario. La llave se mantiene fijada en la posicion «ON».

Boton Emergency Stop (Parada de emergencia)

El boton Emergency Stop (Parada de emergencia) esta disponible en el panel frontal del

Faxitron Core para detener la generacion de rayos X. Esto se suma a los enclavamientos de

seguridad del cajon del sistema.

Indicadores de generacion de rayos X

El Faxitron Core tiene un indicador luminoso de rayos X en el panel frontal y en la interfaz

grafica de usuario, y produce también un tono audible cuando se generan los rayos X.

Acceso al software: Contrasefia opcional

El usuario tiene la opcion de implementar un requisito de «Contrasefia» para abrir el software

de Vision. Cuando esta opcion esta activada, se debe introducir la «contrasefia definida por el

usuario» correcta para abrir el software Vision. Si no se introduce la contrasefia correcta, el

software se cierra.

Sistema de control de rayos X 3.3.0

El sistema de control de rayos X consta de la electrénica del sistema, los cierres de Sistema de control
enclavamiento de seguridad, el botén de encendido de los rayos X, el boton de parada de  de rayos X
emergencia y el software de obtencion de imagenes (Vision) del sistema.

Para obtener imagenes o generar rayos X, el sistema Faxitron Core depende totalmente del
software.
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El software y el firmware del médulo de control supervisan las condiciones del sistema con el 3.3.0 Cont.
fin de determinar:

1) Sise cuenta con el permiso para la obtencién de imagenes

2) Los parametros de la obtencion (el nivel de energia y la duracion)
3) Sidebe suspenderse la obtencion de imagenes

4) Qué mensajes, si los hay, deberan mostrarse

5) Qué indicadores deberan activarse.

Para que se produzca la obtencién de imagenes o la generacion de rayos X, deberan cumplirse
las siguientes condiciones:

1) El software de Vision debera estar abierto

2) El sistema debera estar armado (se habran introducido los datos del paciente)
3) Los cierres de enclavamiento deberan estar cerrados

4) El médulo de control se comunica con el software del sistema (Vision)

5) El generador de imagenes digitales se comunica con el software del sistema
6) Botdn de encendido de los rayos X pulsado

Si se cumplen las condiciones anteriores, el software determinara los parametros de obtencion
de las iméagenes (el nivel de energia y la duracién) y los enviard al médulo de control. El
controlador procesara la sefial y la enviara a la fuente de alimentacién de alta tension (HVPS).
Si el circuito de alta tensién esta activo, la HVPS generara alta tensién, que se enviara al tubo
de rayos X, y se generaran los rayos X. Para informar al usuario de que la obtencién de
imagenes o generacién de rayos X esta en curso, se activaran los indicadores y los mensajes.

Si en cualquier momento de la obtencion de las imagenes se abriera un enclavamiento, la
obtencion se detendra y se mostraran los indicadores y mensajes pertinentes.

3.4.0
Blindaje Blindaje y

El sistema Faxitron Core esta disefiado para generar energias de radiacion ionizante iguales o atenuacion

inferiores a 30 keV.

El acero inoxidable utilizado por el fabricante en el compartimento de rayos X Faxitron Core es
un material de namero atémico (Z) alto que absorbe con eficacia cercana al 100 % de la
radiacion ionizante a este nivel de energia.

No es obligatorio blindarse mas.

Atenuacion

El haz primario procedente del tubo Faxitron Core de rayos X se dirige hacia el suelo del
sistema. Cualquier rayo reflejado o disperso sera absorbido por la parte superior, las paredes
y el frontal del cajon del compartimento de rayos X.

Las mediciones tipicas de la radiacion de fondo en la planta de fabricacion de Faxitron son de
0,1 uSv/h (0,01 mR/h).

Para representar los niveles maximos de energia del sistema y la dispersion maxima del haz,
las mediciones de la dosis se toman a niveles de energia de 30 keV con un bloque de acrilico
de 6 mm en la trayectoria del haz primario. Las mediciones realizadas en superficies accesibles
suelen situarse entre 0,1 y 0,5 pSv/hora (0,01 y 0,05 mR/h).

3.5.0

Faxitron aboga por el seguimiento del principio «tan bajos como razonablemente alcanzables» ALARA
(ALARA). Para realizar la tarea, use niveles de energia que no sean superiores a los

necesarios. Para obtener una calidad de imagen que sea 6ptima, el uso del control automatico

de exposicion (CAE) asegurara que se generen los niveles de energia de radiacién ionizante

mas bajos posible. Con el CAE activado, el sistema expondra brevemente la muestra a un nivel

de energia y duracién predeterminados. El software evaluara la imagen de la muestra y

calculara los mejores ajustes de energia y tiempo.
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REQUISITOS NORMATIVOS

El centro o la institucidn que utilice este sistema sera responsable de asegurar que se cumplan
todas las normativas locales, regionales y federales que afecten al uso de equipos de radiacion
ionizante.

Advertencias
e Antes de utilizar el sistema, lea atentamente las instrucciones.

¢ No utilice el sistema de manera distinta a la del uso previsto, tal y como se describe en este
manual; en caso de duda, péngase en contacto con Faxitron o con el distribuidor autorizado.

¢ No todos los cables de alimentacion tienen la misma clasificacion. No utilice con este sistema
ningun otro cable de alimentacidon que no sea el suministrado. No utilice el cable de
alimentacién de este sistema en ningun otro equipo.

o Este sistema ha sido probado siguiendo las normas internacionales mas estrictas; no
obstante, en lo relativo a los requisitos operativos locales es recomendable que se ponga en
contacto con las autoridades nacionales.

o Este sistema no esta destinado al uso publico. Debera estar situado en una zona en la que
el publico en general no pueda acceder al sistema sin la presencia de un operador.

¢ El uso de controles o los ajustes para realizar procedimientos distintos de los especificados
en el presente documento podra provocar la exposicion peligrosa a la radiacion.

Precauciones generales

Para evitar producir dafios al sistema Faxitron Core, deberan tomarse las siguientes
precauciones:

e Mientras el sistema esté encendido, nunca conecte ni desconecte los cables de
comunicacion y/o alimentacion. Si los cables se conectan o desconectan mientras la camara
estd encendida, podran producirse dafios en el sensor CMOS o en los componentes
electronicos de la camara.

o El sistema de camara es fragil y se debe tener cuidado para no dafiarlo. El sistema de camara
nunca se debera manipular incorrectamente, golpear bruscamente, golpetear ni dejar caer.

¢ El sistema Faxitron Core dispone de un modo de calibraciéon. Para garantizar el correcto
funcionamiento del sistema, la calibracion debera llevarse a cabo diariamente. Consulte el
Procedimiento de calibracién en las secciones 5 y 6 de este manual.

o Asegurese de que el cajon de especimenes esté completamente cerrado antes de apagar la
unidad.

o Asegurese de que el cajon de especimenes esté limpio y libre de especimenes o residuos
antes de apagar la unidad.

4.0.0

Advertencias y
precauciones
del sistema

> B P

>
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Conexiones interoperativas

4.0.0 Cont.

El sistema Faxitron Core es capaz de funcionar como un dispositivo autébnomo, sin entradas ni
salidas hacia otros dispositivos. En el sistema, las imagenes se pueden captar, almacenar y
revisar directamente.

Sin embargo, el sistema dispone de varias interfaces. La interfaz principal es la conexién de
red que permite conectar el sistema a un Sistema de archivo y comunicacién de imagenes
(SACI). Las imagenes pueden ser transmitidas en formato DICOM desde el dispositivo
directamente a la red del centro a través de nuestro software. Para obtener mas detalles sobre
la version de DICOM, consulte la seccién 6. Solamente deberan configurar esta comunicacion
los empleados de Faxitron o el personal de Tl capacitado del centro del usuario.

A continuacion, se enumeran las conexiones del sistema y el uso previsto. Ningun otro tipo de

dispositivo debera conectarse al sistema Faxitron Core sin la aprobacién de Faxitron.

Conexioén

Propésito

Tipo de dispositivo

Usuarios a los que va dirigido

Puerto Ethernet

Almacenar imagenes radiograficas en un

SACl o

Configurado por el personal de

reparar el sistema.

de la parte sistema de almacenamiento de datos en |almacenamiento en |Faxitron o de Tl del centro.
posterior red red Utilizado por profesionales clinicos.
Puerto Ethernet | Permitir la conexion remota por parte del | Conexion a Internet | Personal de Faxitron o de Tl del
de la parte equipo de mantenimiento de Faxitron en red centro

posterior para que Faxitron pueda diagnosticar y

Puerto USB de
la parte frontal

Transferir imagenes desde el dispositivo.
Este solamente se deberd utilizar si el
SACI o la red no estan disponibles.

Dispositivo de
almacenamiento
USB (memoria flash)

Profesionales clinicos o de Tl
que tenga acceso autorizado al
sistema.

Puerto USB de
la parte frontal

Mantener y conservar los archivos del

sistema; es posible que sea necesario
copiarlos en y desde el ordenador. Por
ejemplo, actualizaciones de software o
archivos de registro.

Dispositivo de
almacenamiento
USB (memoria flash)

Personal de Faxitron o de Tl del
centro

Puerto USB de
la parte

Permitir la conexion de una impresora. El
software Vision permite la conexién de

Impresora DICOM o
Windows

Profesionales clinicos o de Tl del
centro

una impresora DICOM o una impresora
estandar compatible con Windows.

posterior

Ciberseguridad

La seguridad de los dispositivos es una responsabilidad compartida entre Faxitron y los centros
médicos. Si no se mantiene la ciberseguridad, se podra poner en peligro la funcionalidad del
dispositivo, la disponibilidad o la integridad por la pérdida de los datos (médicos o personales),
o la exposicién a amenazas de seguridad de otros dispositivos o redes conectados. Para
asegurar la ciberseguridad de sus unidades y conservar su funcionalidad y seguridad, Faxitron
mantiene una serie de controles de ciberseguridad.

A\

Todas nuestras unidades utilizan sistemas operativos estandar de Windows. Durante la
instalacion, recomendamos que el centro implante todas las medidas de seguridad que sean
necesarias y estén definidas por sus propios requisitos internos, como lo haria con cualquier
otro PC conectado a la red.

El centro podra configurar el sistema operativo Windows con todos los protocolos de red y
permisos necesarios. Por ejemplo, podra anadir:

e EIID de usoy las contrasefias,

e La autorizacion por niveles con la autenticacion correspondiente,

e Restricciones a la instalacion del software,

e Requisitos de contenido de confianza, incluida la verificacion del codigo de la firma,

e Configurar las actualizaciones de Windows, incluidas las versiones de seguridad.

HOLOGIC
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Ademas, nuestro software de imagenes (Vision) se puede proteger mediante contrasefia para que
determinados usuarios puedan acceder al sistema operativo sin tener que abrir el software Vision.

La unidad viene con una llave fisica que enciende el sistema de rayos X. Esto permite que el
sistema se bloquee, por lo que incluso si se accede al software no se pueden iniciar los rayos X.

Esta unidad esta disefiada para utilizarse como unidad independiente o conectarse al SACI
interno del centro o a otra red de circuito cerrado. No esta previsto que se conecte a Internet,
a menos que: (a) el centro reciba de Faxitron instrucciones especificas para hacerlo, o (b) el
centro tome las precauciones adecuadas que garanticen la ciberseguridad de la unidad frente
a las amenazas relacionadas con la conexion a Internet.

Para seguir garantizando la seguridad de los productos, segun sea necesario durante todo el ciclo
de vida de la unidad, Faxitron desarrollara actualizaciones o parches para el software de Faxitron.

Se podran implementar medidas de seguridad adicionales, incluido el cifrado, y Faxitron podra
trabajar con el departamento de Tl de los centros para reducir el riesgo de los pacientes como
resultado de la violacion de la ciberseguridad.

Eventos de ciberseguridad

Si se produce un evento de ciberseguridad, desconecte de la red el sistema y péngase
inmediatamente en contacto con Faxitron. Trabajaremos con el departamento de TI del centro
para resolver el problema.

Un evento de ciberseguridad puede detectarse de varias maneras:

e El funcionamiento y/o la conexién de red son mas lentos de lo normal.

e En el navegador de Internet aparecen ventanas emergentes sospechosas o la pagina
de inicio ha cambiado.

e La(s) contrasena(s) ya no funciona(n).
e En el menu de inicio o en la bandeja del sistema hay programas desconocidos.
e Los datos se han perdido, dafiado o alterado.

Limpieza
Compartimento interno

Las muestras que contienen especimenes bioldgicos pueden albergar agentes infecciosos que
son peligrosos para la salud. Siga los correspondientes procedimientos de bioseguridad; cuando
manipule especimenes de tejido o los materiales con los que entren en contacto, utilice guantes.

La dnica parte del compartimento de rayos X accesible para la limpieza es el cajon de
muestras. Puede limpiar suavemente el cajéon de muestras con un pafio suave sin pelusa
humedecido con alcohol isopropilico al 70-90 % o hipoclorito de sodio diluido (la lejia doméstica
al 5,25 %-6,15 % diluida en la proporcién 1:500 ofrece la concentracién adecuada).

e No utilice abrasivos ni disolventes fuertes.

* No frote el area de imagen rebajada del cajon, ya que esto puede rayar la superficie
y crear artefactos de imagenes.

e Para verificar que no dafan el material, pruebe los productos de limpieza en areas
pequefas y poco visibles del cajon.

Exterior

Limpie periddicamente las superficies exteriores con alcohol isopropilico, hipoclorito de sodio,
0 agua con jabdén suave (consulte mas arriba las concentraciones correspondientes).
No empape ni inunde las superficies, ni utilice abrasivos que puedan rayarlas. No permita que
la humedad entre en contacto con ninguno de los componentes eléctricos del sistema. Para
verificar que no dafian el material, pruebe los productos de limpieza en un area pequefia y poco
visible de las cubiertas.

4.0.0 Cont.
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Configuracion del sistema 41.0

El Faxitron Core debe ser configurado por un representante autorizado de Faxitron Bioptics, Configuracién
LLC. Para confirmar que el sistema ha llegado y concertar una cita para la instalacion y del sistema de
configuracion del sistema, pongase en contacto con Faxitron llamando al numero de teléfono especimenes

+1 520-399-8180. Faxit c
axitron core

Inspeccion de las cajas

El sistema Faxitron Core viene en una (1) caja de carton. La caja contiene el armario de rayos
X Faxitron Core, el ordenador, el monitor, el cable de alimentacién, el cable de video, el
cableado, la documentacion, las llaves del armario de rayos X y 25 bandejas de muestras.

Solicite al transportista que lleve la caja a un area donde pueda mantenerse a salvo de robos,
dafios o condiciones ambientales extremas hasta que el representante autorizado de Faxitron
Bioptics, LLC pueda instalar el sistema.

Compruebe si hay dafios en la caja. Si observa algun dafio, pongase en contacto con Faxitron
llamando al +1 520-399-8180.

Elevacién y transporte de las cajas
Precaucion: la caja pesa aproximadamente 36,3 kg (80 libras). La caja debe mantenerse en

posicion vertical, como aparece indicado en las etiquetas del envio. Tenga
cuidado al trasladarla para evitar lesiones y dafios al sistema.

Desembalaje y configuracion del sistema

El sistema Faxitron Core debe ser desembalado y montado in situ por un representante
autorizado de Faxitron Bioptics, LLC. Cuando reciba el sistema, pongase en contacto con
Faxitron Bioptics, LLC llamando al +1 520-399-8180 para ajustar la configuracion del sistema.

Ubicacién
Para permitir que la ventilacién y el acceso al cable de alimentacién y el cableado sean los

adecuados, deje al menos 15 cm (6 pulgadas) de espacio libre detras del armario cuando se
instale.

Condiciones ambientales

Operativas:
Temperatura: entre 15,5y 30 grados C (entre 60 y 86 grados F).
Humedad relativa: <75 %.

Almacenamiento y transporte:
Temperatura: entre 0 y 45 grados C (entre 32 y 113 grados F).
Humedad relativa: <75 %.

El equipo esta disefiado para funcionar en las siguientes condiciones:

e Uso en interiores,
Altitud hasta 2000 m (6562 pies),
Contaminacién de grado 2,

Categoria de sobretension Il
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REQUISITOS DE POTENCIA: maximo de 120 V CA, 60 Hz, 150 W o maximo de 240 V CA, 4.1.0 Cont.
50 Hz, 150 W
POTENCIA CALORIFICA: maximo de 500 BTU/h
CICLO DE TRABAJO DE LOS RAYOS X: 50%
PROTECCION RADIOLOGICA: consulte la seccién 2 de este manual.
Faxitron Core fue disefiado como un sistema estacionario para ser instalado en un escritorio, 4.2.0
mostrador o mesa. Traslado del
Traslado del sistema Faxitron Core: No recomendado. S'Ste"!a de
especimenes

Una vez colocado en su ubicacion final, se recomienda no trasladar el sistema Faxitron Core.

El sistema Faxitron Core no esta disefiado para ser una unidad portatil. Actualmente no se
proporciona carrito, por lo que el sistema informatico se colocara también en una superficie no
portatil.

Precaucion: El armario de rayos X Faxitron Core pesa aproximadamente 18 kg (40 libras) y
no esta disefiado para ser levantado ni transportado. Es un instrumento de
precision que necesita ser manejado adecuadamente. No intente levantar ni
cargar con el sistema.

No bloquee el rea situada detrds o inmediatamente delante de la unidad, ya que este espacio
abierto es necesario para que se ventile el sistema y el ordenador. La ventilacién en la parte
posterior del sistema sera la adecuada, siempre y cuando no se coloquen objetos entre la
unidad y la pared donde esta la toma de corriente eléctrica del sistema.

Para que el personal pueda acceder con seguridad a la puerta de los especimenes, al teclado,
al monitor y al panel de control del sistema, asegurese de que haya una superficie plana y
nivelada exenta de peligros delante del sistema.

Nota: para acceder facilmente al cable de alimentacion del sistema, deje que haya suficiente
espacio en la zona préxima al sistema.

Precaucion: si debe trasladar el sistema Faxitron Core:
e Asegurese de que todos los componentes estén completamente apagados.
e Desconecte los cables de alimentacion de la toma de corriente.
e Desconecte todos los cables de interconexion (es decir, el cable de fibra optica).
e Tenga cuidado al trasladar el armario de rayos X Faxitron Core.

Advertencia: el cable de alimentacién del sistema Faxitron Core viene suministrado con un
enchufe que tiene conexion a tierra. Si no se dispone de una toma de corriente
adecuada que coincida con el enchufe del cable de alimentacion del sistema,
solicite los servicios de personal cualificado para que le proporcione una toma
de corriente eléctrica que sea adecuada. No intente modificar usted mismo el
enchufe ni la toma de corriente.

Advertencia: para evitar producir dafios en la unidad y/o el contacto con tejidos infecciosos,
asegurese de que el Faxitron Core esté completamente limpio y debidamente
embalado antes de retirarlo del uso para realizar el mantenimiento,
transportarlo o eliminarlo.

Faxitron Core

A\
A\
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Antes de encender el sistema, asegurese de que los cables de alimentacidon estén bien
enchufados en el armario Faxitron Core, en el ordenador y en el monitor antes de enchufarlos
en la toma de corriente de alimentacion de la red eléctrica de las instalaciones. También, si es
necesario, conecte un cable de red Cat5 o Cat6 en la conexion de red del ordenador Faxitron
Core y del centro médico.

Consulte la Seccion 4 de este manual, Instalacion y configuracion, y las Guias de configuracion
rapida y de inicio rapido suministradas con el sistema Faxitron Core.

Procedimientos basicos de obtencion de imagenes

Advertencia: El uso de Faxitron Core de una manera diferente a la descrita en este manual
podria resultar en un mal funcionamiento del equipo o en lesiones personales.

Advertencia: Para evitar el contacto con muestras de tejido de pacientes que sean
potencialmente peligrosas, utilice recipientes o guantes autorizados.

Resumen de la secuencia de obtencion de imagenes

Para obtener el resumen del funcionamiento del sistema, consulte la Guia de inicio rapido de
Faxitron Core.

e Abra el cajén de especimenes (pulse el botén negro).

e Coloque los especimenes en un recipiente para especimenes proporcionado por Faxitron
Bioptics, LLC o su institucion y coléoquelos dentro del cajéon Faxitron Core.

o Cierre el cajon de especimenes (pulse el botén negro).

¢ Elija o introduzca a un paciente en el software Vision e inicie la obtencion de imagenes desde
el software.

e Pulse el botén verde Start (Comenzar) en el panel de control de Faxitron Core o en el
software. Esto iniciara la exposicion a los rayos X.

e Espere a que se visualice la imagen.

o Utilice el raton para mover el cursor sobre la imagen visualizada y mueva el cursor hacia
arriba y hacia abajo para ajustar los niveles de brillo u oscuridad, o muévalo hacia la izquierda
o hacia la derecha para ajustar el contraste bajo o alto. Mueva el cursor hasta que la imagen
esté al nivel deseado.

¢ Repita el proceso para el resto de especimenes.

Para obtener instrucciones de funcionamiento mas detalladas, consulte la Seccién 5.2.

Para obtener informacién sobre el funcionamiento avanzado del software, consulte la Seccién
6 del Manual del usuario.

5.0.0

Descripcion
general del inicio
rapido

Figura 5.0.1
Panel frontal de Faxitron Core

B> >
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Informacién general sobre la puesta en marcha

El encendido (puesta en marcha del sistema) se lleva a cabo una sola vez al comenzar a
utilizarse el sistema. Si tiene la intencion de utilizarlo de nuevo, es recomendable que, una vez
se haya realizado la secuencia de encendido, deje el sistema ENCENDIDO el resto del dia.

Protocolo de la secuencia de puesta en marcha del sistema
Sistema de encendido

e Ponga el ordenador y el monitor en la posicion «ON» y permita que se inicie
completamente en Windows.

e Coloque el interruptor de alimentacion en la parte posterior del
armario Faxitron Core en la posicion «ON». Véase la Figura 5.1.1. ON
(ACTIVADO)
e Gire la cerradura de contacto de la parte frontal del armario
Faxitron Core hasta «ON» (en el sentido de las agujas del reloj

a la posicion de las tres). Véase la Figura 5.1.2. OFF

(DESACTIVADO)

e Verifique que no haya nada en el cajon de muestras Faxitron

Core.
‘ Apagado
‘ Encendido

Puesta en marcha del software

e Haga «doble clic» en el icono de Vision situado en el escritorio de
Windows.

e  Aparecera brevemente un cuadro de dialogo para indicar que el
software se ha inicializado y se esta cargando.

e El software se abrira en la pantalla «Home Menu» (Menu de inicio)
o «Calibration» (Calibracion), dependiendo del tiempo transcurrido desde la ultima
calibracion.

Si se ha llevado a cabo una calibracién en las ultimas 12 horas, el software se abrira en Home
Menu (Menu de inicio).

Para garantizar una calidad de imagen 6ptima, Faxitron recomienda calibrar el sistema cada
dia en el momento de la puesta en marcha o si el sistema se ha trasladado de lugar.

Para iniciar una calibracion de forma manual, haga clic en el botén Calibrate (Calibrar) de
Home Menu (Menu de inicio) y, a continuacion, haga clic en el boton Start Calibration (Iniciar
calibracion). El software volvera al Home Menu (Menu de inicio) cuando se complete la
calibracion. Véanse las Figuras 5.1.4y 5.1.5.

Start Procedure

>

Shut Down

Review

5.1.0
Secuencia de
encendido

5.1.1
Puesta en marcha
del sistema

Figura 5.1.1
Interruptor principal de
encendido/apagado

Figura 5.1.2
Cerradura de contacto

Figura 5.1.3
Icono de escritorio de VISION

Figura 5.1.4
Botén de Iniciar calibracion
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Calibrar 51.2
NOTA: para que la calidad de la imagen sea 6ptima, se recomienda calibrar el sistema al menos . . 2
una vez al dia, antes del primer uso. Calibracion
e El software se abrira en la pantalla Calibration (Calibracion) si han pasado 12 horas
desde la ultima calibracion.
e Presione el boton Start Calibration (Iniciar calibracién) y permita que el sistema
complete la calibracién.
Figura 5.1.5

Boton de Iniciar calibracion

Start Calibration

Last Calibrated: 200 14:41:53 Tue

ENSURE THE CHAMBER IS EMPTY BEFORE CALIBRATION

Calibration before beginning any procedure is recommended

e Se abrira el cuadro de didlogo de calibracién que mostrara el progreso de la calibracion.

Figura 5.1.6
Wl deddogo Calbracion

de rayos X
Calibrating
4. SYSTEM IN CALIBRATION
e El cuadro de didlogo se cerrara cuando finalice la calibracién. El software ira a la
pagina Home Menu (Menu de inicio).
Inicio del procedimiento de obtencién de imagenes 52.0

e En la pagina Home Menu (Menu de inicio) (véase la Figura 5.1.4), seleccione el botén Start ~ Obtencion
Procedure (Iniciar procedimiento). de imagenes

e Al usuario se le daran las opciones de Select from Worklist (Seleccionar en la lista de
trabajo), Manual Entry (Introduccién manual), Select from Database (Seleccionar en la
base de datos) o Continue with current patient (Continuar con el paciente actual). Véase

la Figura 5.2.1.
Figura 5.2.1
< Botones para la introduccion
de datos del paciente

Continue with current patient

Database E
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e Para introducir manualmente un nuevo procedimiento, seleccione el botén Manual Entry

(Introduccion manual).

NOTA: esta seccion solamente versa sobre la «Introduccién manual» de los datos del

paciente; las opciones restantes se tratan en la Seccién 6 de este manual.

e Se abrira el cuadro de didlogo «Patient Information Editor» (Editor de la informacion sobre el

paciente).

Patient Name:
Patient ID:
Accession #:
Date of Birth:

Sex:

Procedure Name:

Laterality:

Position View:
Body Part:
Refer. Physician:
Technician:

Technician ID:
Study Name:

Study ID:

Accept

Nota:

(Lateralidad).

¢ Introduzca todos los campos obligatorios. Si falta algun campo obligatorio, el boton Accept

L Jane

L]
i

.3 JD12
L 123456789

1920/03/16

*
-
o«

Start a New Patient or Procedure

los campos obligatorios aparecen indicados con un
asterisco blanco (*). Los campos obligatorios y predeterminados
son: Patient Name (Nombre del paciente), Patient ID (ID del
paciente), Accession Number (Numero de ingreso) y Laterality

(Aceptar) no estara activo. El usuario podra completar otros campos si lo desea.

Nota: la fecha debera indicarse como aaaa/mm/dd (por ejemplo, 1962/08/13).

¢ Para activar la obtencién de imagenes, seleccione Accept (Aceptar).

o El sistema estara listo para obtener imagenes.

5.2.1

Introduccion
manual de los
datos del paciente

Figura 5.2.2
Editor de la informacion sobre la
obtencion de imégenes
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Coémo realizar una imagen o comenzar la exposicién a los rayos X
Para obtener una imagen de rayos X con el sistema Faxitron Core:

e Abra el cajon del compartimento de rayos X pulsando el botéon negro y coloque la bandeja
Faxitron Core con los especimenes en el cajon. Cierre el cajon pulsando de nuevo el botén
negro.

e Presione el botdn verde Start X-Ray (Comenzar radiografia) en el panel de control o en el
software.

e Espere a que se visualice la imagen.

' . Botdn X-Ray
(rayos X)

Boton
«Start X-Ray»
(Comenzar radiografia)
en la pantalla

NOTA: el modo predeterminado de rayos X del Faxitron Core es Full Auto (Totalmente
automatico). El sistema realizard dos radiografias; la primera, para determinar los
ajustes optimos, y la segunda, para obtener la imagen. Los ajustes utilizados durante
las exposiciones se mostraran en la pantalla LCD de los armarios.

El software Vision esta configurado para guardar automaticamente la imagen en la base de datos
de Faxitron, en la unidad local del ordenador del sistema. El usuario también puede guardar la
imagen en el servidor de instalaciones haciendo clic en el icono «PACS» (SACI). Consulte las
secciones 6.4.1, 6.6.0 y 6.7.0 para obtener mas informacion sobre como guardar las imégenes.

Para obtener mas informacion sobre como ajustar la configuracion de las imagenes, los
controles de rayos X y las opciones de revision y guardado, consulte la Seccion 6.

Salir del software VISION

Haga clic en el boton Shut Down (Apagado) y, a continuacion, haga clic en OK (Aceptar). Esto
apagara el equipo. El apagado se puede seleccionar en la pantalla de inicio o en la pantalla de
obtencion de imagenes utilizando los botones siguientes.

Boton Shut Down (Apagado) en la pantalla Acquisition
(Obtencidn).

of ©

Shut Down

Botén Shut Down (Apagado) en el Home Menu (Menu de inicio).

Apague el armario de rayos X Faxitron Core

Una vez que el ordenador esté apagado, gire la cerradura de contacto hasta la posicién de
apagado (posicion vertical).

5.2.2
Cémo comenzar
una exposicion

Figura 5.2.3
Cajon Faxitron Core

5.2.3
Cémo apagar
del sistema

Figuras 5.3.1y 5.3.2.
Botones de Shut Down (Apagar
el sistema) y salir del programa
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El software Vision de es un completo paquete de obtencion y procesamiento de imagenes que
esta disefiado exclusivamente para trabajar con los generadores de rayos X de Faxitron
Bioptics (como los sistemas VersaVision, Faxitron Path, Faxitron Core y Faxitron OR). Ademas
de las funciones de obtencién y procesamiento, el software ofrece un amplio médulo de base
de datos, que permite el control y el mantenimiento de archivos, y el almacenamiento, la
tramitacién y la recuperacion de las imagenes por parte del usuario. El software también es
compatible con Imagenologia Digital y Comunicaciones en Medicina (DICOM), lo que permite
guardar e imprimir imagenes de los pacientes en formato DICOM 3.0. El software ha sido
preinstalado en el ordenador que se incluye con el sistema de rayos X.

Para obtener la mejor calidad de las imagenes, sera necesario calibrar el sistema cada nuevo
dia de uso. Para garantizar que la calidad de las imagenes sea 6ptima, el usuario del sistema
también podra realizar la calibracion en cualquier momento.

Después de la calibracién, se mostrara Home Menu (Menu de inicio), que permite navegar al
resto de areas del software. Para facilitar el uso, se proporcionan botones de aplicacién. Véase
la Figura 6.0.1. Estos botones estan en el centro de la pantalla. Las descripciones y definiciones
de los botones aparecen explicadas en las proximas secciones de este manual.

Start Procedure

Shut Down

Protocolo de la secuencia

Para garantizar que la funcionalidad del sistema y la calidad de las imagenes sean las
adecuadas, debera seguirse esta secuencia de puesta en marcha:

e Encienda el armario Faxitron Core utilizando el interruptor situado en la parte posterior del
armario. (El interruptor de alimentacion esta junto a la toma de corriente del cable de
alimentacion). Pulse «I» para <ENCENDERLO» y «0» para «<APAGARLO».

¢ Encienda el sistema Faxitron Core «ON» introduciendo la llave Faxitron Core en el interruptor
de cerradura con llave, situado en el panel frontal, y girandola en el sentido de las agujas del
reloj hasta la posicion de las 3. Nota: la llave no se puede extraer en esta posicion.

e Encienda el ordenador y el monitor.

e Si Vision no se inicia automaticamente, haga doble clic con el botdn
izquierdo del raton en el icono del software Vision (ubicado en el
escritorio de Windows). Véase la Figura 6.1.1. Aparecera brevemente un
cuadro de didlogo para indicar que el software se ha inicializado y se esta
cargando.

e El software Vision se abrira en Home Menu (Menu de inicio) (véase la
Figura 6.0.1) o en la pagina Calibration (Calibracion) (véase la Figura 6.2.2), dependiendo
del tiempo transcurrido desde la Ultima calibracién del sistema.

e Consulte los protocolos de calibracion en la Seccién 6.2.0 «Descripcion general de la
calibracion de la camara».

6.0.0
Descripcion
general del
software Vision
de

Figura 6.0.1

Software Vision de

Home Menu (Start-up Screen)
(Ment de inicio [Pantalla de
puesta en marcha])

6.1.0
Puesta en marcha
del software

A\

Figura6.1.1
Icono de escritorio del software
Vision
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Introduccién a la calibracion

Para optimizar la calidad de las imagenes, el software Vision y el hardware requieren la
realizacion periddica de la calibracion. Esta calibracion requiere la obtencion de imagenes de
referencia.

En el momento de la puesta en marcha inicial del sistema, o en cualquier momento deseado
por el usuario, se podra solicitar y realizar la calibracion del sistema. Se recomienda que,
transcurrido un periodo de doce (12) horas, se realicen las siguientes calibraciones.

Estas imagenes de calibracién de referencia se utilizan para calibrar, pixel por pixel, una
imagen de rayos X «sin procesar» con el fin de generar una imagen «corregida», que sera
visualizada. Las correcciones realizadas a la imagen abarcan correcciones de ganancia,
contraste y linealidad.

Secuencia de la calibracion

Para mayor comodidad, el software Vision combina los numerosos pasos de calibracién en un
solo paso unificado.

Cuando un sistema Faxitron de rayos X ha estado apagado durante mas de doce (12) horas,
el sistema solicitara automaticamente que se vuelva a calibrar. Se recomienda
encarecidamente que el sistema se vuelva a calibrar tras periodos prolongados de inactividad
o después de que el sistema se traslade de una estancia a otra que tenga unos parametros de
temperatura o humedad ambiente potencialmente diferentes.

Para calibrar el sistema en cualquier momento, haga clic en el
botén Calibrate (Calibrar) en Home Menu (Start-up Screen) (Menu @
de inicio [Pantalla de puesta en marcha]) de Vision y, a

continuacién, presione Start Calibration (Iniciar calibracién).
Véanse las Figuras 6.2.1y 6.2.2. Durante la calibracion, el dialogo :
mostrard un mensaje de estado. Véase la Figura 6.2.3. Calibrate

2007/07/31 14:41:53 Tue

Start Calibration

1 14:41:53 Tue

Calibration before beginning any procedure is recommended

Calibrating

a4 SYSTEM IN CALIBRATION

4

Durante la calibraciéon, puede que se generen rayos X. Durante la generacién de rayos X, se
hara visible el boton Stop X-Ray (Detener rayos X) para permitir que el usuario tenga la opcion
de detener los rayos X utilizando el software.

6.2.0
Descripcion
general de la
calibracion de la
camara

Figura6.2.1
Botdn Calibrar del Menu de inicio

Figura 6.2.2
Boton de Iniciar calibracién

Figura 6.2.3
Estado de la calibracion
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A continuacion se presenta un resumen del protocolo de calibracion avanzada para «ambos»
(el campo plano y la imagen):

Coloque el atenuador uniforme sobre el sensor. Toda la superficie del sensor debera estar
cubierta por el atenuador. Para obtener resultados ideales, el atenuador debera ser mayor que
el area de obtencién de imagenes del sensor.

Para enfocar el menl, desde el Home Menu (Menu de inicio) del software de obtencion de

imégenes, presione el icono ” situado arriba a la derecha. En el menu horizontal situado en la parte
superior de la pantalla, seleccione el elemento del menu desplegable «Tools» (Herramientas) y, a
continuacion, vaya hasta «Advanced Tools» (Herramientas avanzadas) y, después, hasta «X-Ray
Calibration/Exposure Setup» (Calibracion de rayos X/Configuracion de la exposicion).

| X-ray Generator and Expost

GEMERATOR SETTINGS

KV Currert [ 21.0 ﬂ
md Current | 1.0

- 21.0
ki H-rap Cal ADU/s 16956
ki M | z
lmag:nua 21.0 Acquire

Magnification | 1.450 e

NUMBER OF CAL IMAGES O
#erap Cal [Flat-Field) Averages |5

EXPOSURE SETTINGS
SetFor (7 Werap Cal [Flat-Field]

Test Exposure Usger Time/ADU Target
2.00 Select

* Manuallmage ¢ Both

Time [] " Time ™ &DU

Time[s] | 462

Estimate/Calculate

A0U |BDDD.D

IMAGIMNG MODE
[~ Apply Manual Imaging Settings On Exit, Dizengage Preshot

Accept Seftings |

Cancel

NOTA: los valores de kV, el tiempo de exposicion y las unidades analégico-
digitales (UAD) podrian ser diferentes de los mostrados.

e En «X-Ray Generator and Exposure Settings» (Generador de rayos X y ajustes de la
exposicion), introduzca el ajuste de kV del generador en el campo correspondiente.

¢ Deje la «Magnification» (Ampliacion) en el ajuste predeterminado de 1,450 (la ampliacién
esta fijada en el sistema Faxitron Core).

¢ En el cuadro de dialogo, seleccione el botdon «Set for» (Ajustar para) «Both» (Ambos).

e Deje el ajuste predeterminado «user ADU target» (blanco de las UAD del usuario).

La exposicién a los rayos X se interrumpira cuando el sensor haya acumulado un nivel medio
de sefal de UAD que sea aceptable para el generador de rayos X que usted tiene.

¢ Deje el tiempo de exposicion predeterminado de la prueba y haga clic en el botéon Acquire
(Obtener). El sistema dara inicio automaticamente a los rayos X y obtendra una imagen.

e Cuando la exposicidn a los rayos X haya finalizado, haga clic en el boton Estimate/Calculate
(Estimar/Calcular).

e Registre la lectura del tiempo de exposicion «Time[s]» (Tiempol[s]) calculado. El sistema
calculara este tiempo y el nimero aparecera en gris.

e Introduzca la lectura del tiempo de exposiciéon «Time[s]» (Tiempo[s]) calculado en la casilla
de tiempo «Test Exposure» (Exposicion de prueba). Para dar inicio automaticamente a los
rayos X y obtener una imagen, presione el botén Acquire (Obtener).

e Cuando la exposicion a los rayos X haya finalizado, haga clic en el botén Estimate/Calculate
(Estimar/Calcular).

e Registre la lectura del tiempo de exposicion «Time[s]» (Tiempo[s]) calculado.

e Vuelva a introducir la lectura del tiempo de exposicion calculado en la casilla de tiempo «Test
Exposure» (Exposicion de prueba).

6.2.0 Cont.

Figura 6.2.4
Generador de rayos X y cuadro
de dialogo de la exposicion
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e Haga clic en el boton Accept Settings (Aceptar configuracion).

¢ Realice un procedimiento estandar de calibracion, tal y como se describe en la seccién
«Descripcion general de la calibracion de la camara.

Como se describié anteriormente, puede que los usuarios experimentados quieran ajustar
«X-Ray Cal (Flat-Field)» (Calibracién de rayos X [Campo plano]) y «Manual Image» «Exposure
Settings» (Imagen manual) (Ajustes de la exposicidn) por separado o «Both» (Ambos) (el
campo plano y la imagen manual). Seleccionando el botén de opcién «Flat Field» (Campo
plano), el sistema determinara el tiempo de exposicion éptimo para obtener imagenes de
campo plano al nivel de UAD deseado. Por consiguiente, la seleccién de «Manual Image»
(Imagen manual) determinara el tiempo de exposicion éptimo para el sistema con un objeto
que atenue la sefial de rayos X. Para obtener los mejores resultados, el objeto debera cubrir
toda el area de obtencion de imagenes del sensor.

Después de seleccionar «X-Ray Cal (Flat-Field)» (Calibracién de rayos X [Campo plano]) o
«Manual Image» (Imagen manual), se ha ajustado el nivel de UAD; seleccione el botén Acquire
(Obtener). Para seleccionar «Manual Image» (Imagen manual), conviene tener el objeto o el
atenuador de rayos X en el haz de rayos X. Para generar rayos X y obtener una imagen, pulse
el boton Acquire (Obtener). Cuando la exposicion a los rayos X haya finalizado, haga clic en
el botén Estimate/Calculate (Estimar/Calcular). El sistema calculara el tiempo 6ptimo y el
ndmero aparecera en gris. Para guardar los «Exposure Settings» (Ajustes de exposicion) en el
archivo de configuracion del sistema, haga clic en el botdon Accept Setting (Aceptar ajuste).

Nota: solamente se guardaran los ajustes del botén de opcién que haya seleccionado.

A continuacion, realice un procedimiento estandar de calibracion, tal y como se describe en la
seccién «Descripcion general de la calibracion de la camara.

Periédicamente, convendria incorporar las caracteristicas de atenuacion de los rayos X de un
atenuador uniforme en las imagenes de calibracion de referencia de campo plano. Por ejemplo,
si todos los objetos radiografiados se colocan sobre una placa plastica delgada, las
caracteristicas de atenuaciéon de los rayos X de la placa se observaran en cada imagen
obtenida. En este caso, la colocacién de la placa dentro del haz de rayos X, durante la obtencion
de la imagen de calibracion de referencia de campo plano, podria mejorar la calidad de las
imagenes.

El boton Start Procedure (Iniciar procedimiento) (véase la Figura 6.0.1) lleva al usuario a la
pagina Patient Data Entry (Introduccién de datos del paciente), que proporciona métodos para
introducir los datos de los pacientes. Si no se ha configurado una lista de trabajo, la opcién
aparecera en gris y solamente se podra acceder a las opciones Continue with Current Patient
(Continuar con el paciente actual), Manual Entry (Introduccion manual) y Select from Database
(Seleccionar en la base de datos). Las opciones aparecen explicadas en las siguientes
secciones.

<

Select from Work List

>

Continue with Current Patient Sl B e E
JANE DOE

6.2.0 Cont.

6.2.1

Calibracion
avanzada

6.3.0

Datos del paciente

Figura6.3.1
Pantalla Pati

ent Data Entry

(Introduccién de datos del

paciente)
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Seleccionar en Work List (Remote Modality Work list) (Lista de
trabajo [Lista de trabajo de modalidad remota))

Si se ha configurado una lista de trabajo, el usuario podra hacer clic en el boton Select from Work
List (Seleccionar en la lista de trabajo), que mostrara la pagina que aparece en la Figura 6.3.2.

Worklist

Patient 1D

Search Paramet... AV33671 o001 KRISTYAKAITLYN  1678/03/04 MG st

AV35672 00002 GARCIA®MARIA  1678/03/04
Patient Name

AV35673 00003 SMITHAMARY 1678/03/04 MG FA
Patient ID

AV3SE74 00004 HOUSTONACARLA  1732/04/31 MG M

= 0 om o o=

Birth Date

AV35ETS 00005 DOE"JANE 1678/03/04 MG FA

Proc. Start Date 2019/04/15
Accession No,
Modality

Perf, Physician

Station AE Title FAXTIRON_DR

Station Name

NOTA: todos los datos de los
pacientes son ficticios.

Cualquier parecido con personas
reales es pura coincidencia.

A la izquierda hay varios filtros que pueden utilizarse para buscar procedimientos programados
para la entidad de aplicacion (AE) de la terminal. Verifique que esté definido el titulo AE de la
terminal; a continuacion, cualquier campo individual o cualquier combinacién de campos podra
utilizarse como filtro para buscar procedimientos programados para este AE. Seleccionando el
botén Query (Consulta), situado en la esquina inferior izquierda, la tabla se rellenara con las
entradas que coincidan con la informacién consultada.

El usuario podra entonces hacer clic en cualquier entrada y pulsar Submit (Enviar) para rellenar
automaticamente el editor de la informacién sobre la obtencién de imagenes con la informacion
del paciente.

AVISO: el usuario también podra hacer doble clic en cualquier entrada de la tabla para acceder
rapidamente al editor de la informacién sobre la obtencién de imagenes sin tener que presionar
Submit (Enviar).

Se abrira el editor de la informacion sobre la obtencién de imagenes Patient Information Dialog
(Dialogo de informacion sobre el paciente). Véase la Figura 6.3.3. Para proceder a la obtencién
de imagenes, rellene el resto de los campos obligatorios y haga clic en Accept (Aceptar).

6.3.1
Seleccionar en la
lista de trabajo

Figura 6.3.2
Dialogo de busqueda en la lista de
trabajo de la modalidad
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6.3.1 Cont.
Nota: los campos obligatorios aparecen Figura 6.3.3
indicados con un asterisco blanco (*). BEZTEITLEEEES | Nooe | Editor de la informacion sobre la
Los campos obligatorios y obtencion de imagenes

. . Patient ID:
predeterminados son: Patient Name g /04567

(Nombre del paciente), Patient ID (ID del ERCEESELES Y 18273
paciente), Accession Number (NUmero
de ingreso) y Laterality (Lateralidad).

Date of Birth: 1920/03/20

Sex:
Antes de poder seleccionar el botéon Accept
(Aceptar), el usuario debera introducir todos los
campos obligatorios. Si asi lo desea, el usuario
también podra introducir los campos Date
(Fecha), Referring  Physician  (Médico Laterality:
remitente), Procedure Name (Nombre del
procedimiento), Sex (Sexo), Technician
(Técnico), Position View (Vista de la posicion), Body Part:
Body Part (Parte anatémica) y Study ID
(Identificacion del estudio). EI nombre del
procedimiento, la vista de la posicién y la parte Technician:
anatémica se eligen mediante un menu
desplegable.

Procedure Name:

*

=
A 4 o

Position View:

Refer. Physician:

Technician ID:

Nota: la fecha debera introducirse en el
formato aaaa/mm/dd (por ejemplo, Study Name:
1962/08/13). Si no se introduce la fecha
vélida, se podran producir errores al
intentar recuperar las imagenes.

Study ID:

Nota: en funcién de la aplicacion, «los campos
obligatorios» pueden ser modificados o
eliminados. Pdngase en contacto con el
servicio de asistencia técnica de
Faxitron para obtener mas informacién.

Para regresar a la pagina de introduccién de datos de los pacientes, seleccione Accept
(Aceptar) para continuar o Start a New Patient or Procedure (Iniciar un paciente o
procedimiento nuevo).

Continue with Current Patient (Continuar con el paciente actual) 6.3.2

. ) . . . . Continue with
Haga clic en este boton para continuar con el procedimiento del paciente actual. Se abrira Current Patient
«Image Information Editor» (Editor de la informacion de las imagenes). Véase la Figura 6.3.3. u e_ atie
Siga el procedimiento y las notas anteriores. (CO ntinuar con el

paciente actual)

Manual Entry (Introduccién manual) 6.3.3
. ) . . L » Manual Entry
Haga clic en este boton para introducir manualmente un nuevo procedimiento. Se abrira el

«Ilmage Information Editor» (Editor de la informacion de las imagenes). Véase la Figura 6.3.3. (Introduccmn
Siga el procedimiento y las notas anteriores. manu aI)
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Select from Database (Seleccionar en la base de datos)

Si selecciona el boton Select from Database (Seleccionar en la base de datos), aparecera la

siguiente pagina. Véase la Figura 6.3.4 siguiente.

Database

Fatient IO

Search Parameters: 519856

04587

Patient 1D

1056

Last Name
First Name
Middle Name
Time Modified
Date of Birth

Sex

El usuario selecciona a un paciente en la tabla situada en el lado derecho de la paginay, a
continuacién, hace clic en el boton Accept (Aceptar), que abre el editor de la informacion sobre
las imagenes. (Nota: para abrir el editor de informacion sobre las imagenes, el usuario también
puede hacer doble clic en la entrada de la tabla). A continuacién, siga el procedimiento y las

notas de las paginas 6-7.

Nota: para ver la informacién oculta de los pacientes, utilice la barra de desplazamiento situada

en la parte inferior de la pantalla.

Vision permite al usuario reducir la lista de pacientes introduciendo informacién especifica en
la ventana «Search Parameters» (Parametros de blsqueda) situada en el lado izquierdo de la
pagina. Solamente se mostraran aquellos pacientes que coincidan con todos los parametros

de busqueda.

-

DOE JENNIFER

DOE JANE 2019/03/22 12:5... 1920/03/0

DOE 2an 2019/03/22 12:4... 19320241

NOTA: todos los datos de los
pacientes son ficticios.

Cualquier parecido con personas
reales es pura coincidencia.

2019/03/22 12:4... 1935/05/0

6.3.4

Select from
Database
(Seleccionar en la
base de datos)

Figura 6.3.4
Seleccion de pacientes en las
entradas de la base de datos local
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Si el usuario desea cambiar o ver la informacion después de haberla introducido,

Data (Datos del paciente) situado en la esquina superior izquierda de la pantalla.

pero antes de haber tomado una imagen, podra hacer clic en el icono Patient %

Véase la Figura 6.3.5.

Se abrird la ventana de edicion de la informacion sobre el paciente o sobre la obtencién de
imagenes. Esta ventana de edicidn se rellenara con toda la informacién que se haya
introducido o seleccionado previamente. Véase la Figura 6.3.6. Nota: la ventana de edicion

incluira ahora el botdn Cancel (Cancelar).

El usuario podra cambiar o afiadir
informacion que desee y luego hacer clic en:

e el boton Accept (Aceptar) para guardar los
cambios y continuar con la obtencion de

imagenes;

¢ el boton Cancel (Cancelar) para cancelar
los cambios y continuar con la obtencion de

iméagenes. El software volverd a

informacién original sobre el paciente que se

haya introducido, o

e el botén Start a New Patient or Procedure
(Iniciar un paciente o procedimiento nuevo),
que devolvera al usuario a la pantalla de
introduccion de datos del paciente. Véase la

Figura 6.3.1.

Una vez que el usuario haga clic en el botén Accept (Aceptar), el sistema estara listo para

obtener iméagenes o radiografias.

Las radiografias se comenzaran presionando el botén verde Start (Comenzar) en la parte
frontal del armario Faxitron Core o haciendo clic en el botén Start X-Ray (Comenzar
radiografia) situado en la esquina inferior derecha de la pantalla. Véase la Seccién 5.2.2: Cémo
comenzar la exposicién. El sistema tomara una breve radiografia «de muestra», 0 una toma
previa (que se explica en la Seccion 6.4.4), seguida de una exposicién mas prolongada para
obtener la imagen. El software procesara la imagen antes de que se muestre en la pantalla del
monitor. Una vez visualizada la imagen, se activaran los botones situados en los lados
izquierdo y derecho de la pantalla, tratados en toda esta seccion.

Patient Name:

Patient ID:

Accession #:

Date of Birth:

Sex:

Procedure Name:

Laterality:
Position View:
Body Part:
Refer. Physician:
Technician:

Technician ID:

Study Name:

Study ID:

i sane | flooe |

L JD4567

*

1920/03/20

@

Female

*

=
A4 >

0
o
5
o
i,

Start a New Patient or Procedure

6.3.5
Icono de datos del
paciente

Figura 6.3.5
Icono de datos del paciente

Figura 6.3.6
Editor de la informacion sobre la
obtencién de imagenes
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Después de obtener una imagen, el usuario podra
ver, pero no editar, la informaciéon del paciente
haciendo clic en el icono Patient Data (Datos del
paciente) que se muestra en la Figura 6.3.5. Esto
mostrara un cuadro de dialogo modificado Patient
Information (Informacién sobre el paciente), como
se muestra en la Figura 6.3.7. Este cuadro
proporciona dos botones: Close Dialog (Cerrar
didlogo) o Start a New Patient or Procedure (Iniciar
un nuevo paciente o procedimiento). Después de
obtener una imagen, el usuario podra ver, pero no
editar, la informacién del paciente haciendo clic en
el icono Patient Data (Datos del paciente) que se
muestra en la Figura 6.3.4. Esto mostrara un cuadro
de didlogo modificado Patient Information
(Informacién sobre el paciente), como se muestra
en la Figura 6.3.7. Este cuadro proporciona dos
botones: «Close Dialog» (Cerrar diadlogo) o «Start a
New Patient or Procedure» (Iniciar un nuevo
paciente o procedimiento).

Una vez tomada la imagen, se
podran ver las propiedades de
la imagen actual pulsando el
icono (i) situado en la esquina
superior derecha. Véase la
Figura 6.3.8. Aparecera el
cuadro de didlogo Image
Properties (Propiedades de la
imagen) en la esquina superior
derecha de laimagen. El cuadro
es semitransparente  para
permitirle a uno ver lo que hay
por debajo del cuadro. Véase la
Figura 6.3.9.

1.450X

Patient Name:

Accession #: E N 918273
Date of Birth: 1920/03/20

Sex:

Procedure Name:
Laterality:
Fosition View:
Body Part:

Refer. Physician:
Technician:

Tachnician (0

Study Mama:
Study D¢
1

Close Dialog

< Start a New Patlent or Procedure

2019/02/27 10:45:43 Wednesday

21.0kV, 1.00 mA, 4.29 mAs, 4.29s, 0.33s, 0.00s

120190227104543.dcm

C:\Faxitron\Data\

Faxitron Bioptics, LLC

* N I .

Patiant ID: 0 Jpase7

6.3.5 Cont.

Figura 6.3.7

Dialogo de informacion sobre el
paciente tras obtener las imagenes

Figura 6.3.8

Dialogo Propiedades de la imagen

Figura 6.3.9
Propiedades de la imagen
(solo lectura)
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El software Vision proporciona varias herramientas y menus para controlar varios atributos o §.4 .0
parametros de las imagenes, la obtencion de rayos X, las vistas de imagen, las herramientas Barra d
de imagen y los ajustes o0 accesos de DICOM. Las herramientas mas utilizadas estan situadas arra _e
en una barra de herramientas. La barra de herramientas y los menus se describen con mas herramientas
detalle en las proximas paginas. y menUs
. . : . . : 6.4.1
Con un solo clic, el software Vision permite acceder a una serie de herramientas o funciones de
Barra de

uso comun con una barra de herramientas vertical ubicada en el lado izquierdo de la pantalla.
En las paginas siguientes se ofrecen descripciones mas detalladas. Véase la Figura 6.4.1.

View / Change Patient Information
(Ver o modificar la informacion

sobre el paciente)

(Véase la Seccion 6.3.5 y Figura 6.3.5)

Icono de mejora de laimagen

Herramienta Nivel de la ventana
y contraste

Herramienta Zoom digital

Herramientas de anotacién

PACS Save (Guardar en SACI)

PACS Print (Impresion en SACI)

herramientas lateral

Figura 6.4.1

NOTAS: Barra de herramientas lateral

las siguientes herramientas estan

siempre activas en la pagina de

obtencion de imagenes:

e Ver o modificar la informacién sobre
el paciente

e Control de la exposicion

¢ Volver al menu principal

e Apagado del sistema

Las siguientes herramientas se
desactivaran después de introducir los
datos del paciente y solamente se
activaran tras obtener una radiografia:
e Mejorar la imagen

¢ Nivel y contraste de la ventana

e Zoom digital

¢ Anotacioén

Las herramientas PACS Save
(Guardar en SACI) y PACS Print
(Impresién en SACI) solamente se
activaran después de realizar una
radiografia y cuando el sistema esté
conectado a una red SACI.

Control de la exposicién (Panel de control del dispositivo)

Back to Main Menu (Volver al menu principal)

Apagado del sistema

HOLOGIC
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SECCION

Software
Vision
Enhance Image (Mejorar imagen) 6.4.1 Cont.
El botén mostrado en la Figura 6.4.2 procesara la imagen en la pantalla para enfatizar en la
imagen los detalles mas pequefios, como las microcalcificaciones y las pequefias Figura 6.4.2
masas. /¥ Icono de mejora de la imagen

En la obtencién de imagenes avanzadas, el algoritmo cominmente denominado «ecualizacion
periférica» 0 «ecualizacién del espesor» se aplica a toda laimagen. Ademas de este algoritmo,
Faxitron emplea un segundo algoritmo desarrollado internamente y llamado «énfasis de las
calcificaciones». Este algoritmo secundario fue creado para resaltar pequefios detalles de la
imagen y hacerlos mucho mas faciles de ver y analizar.

Dado que las imagenes de los pacientes constituyen una categoria mas general en cuanto a
las posibles geometrias y la variedad de espesores, puede que haya geometrias de las
muestras que representen un reto, y el usuario debera utilizar esta herramienta con cuidado.

El sistema estara inactivo (en espera) durante el proceso y, una vez finalizado, el botén
permanecera pulsado o activo. El usuario podra deshacer el proceso pulsando de nuevo el
botén.
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SECCION
Software
Vision

Ajuste de lainversion, el nivel de la ventanay el contraste

El botdn, mostrado en la Figura 6.4.3, abrira la herramienta de ajuste Window Level and
Contrast (Nivel de la ventana y contraste). Esta herramienta permite al usuario ajustar el nivel
de la ventana y el contraste de la imagen. El usuario también podra restaurar el contraste
original pulsando el boton Original Contrast (Contraste original) o invertir la imagen pulsando
el boton Invert (Invertir). La inversion cambia el esquema cromatico de ser predominantemente
negro a ser predominantemente blanco, o viceversa. Véase la Figura 6.4.4 siguiente.

El usuario también podra ajustar con la barra deslizante el
contraste de la imagen deseado haciendo clic en la barra y
moviéndola hacia arriba y hacia abajo, o haciendo clic en
cualquiera de las flechas de la barra, para mover los limites
inferior o superior del nivel de la ventana. Véase la Figura 6.4.3
(informalmente también se denomina «Equilibrado de la
ventanay).

Original Contrast

Invert

A continuacion se muestra el ejemplo de una inversion:

- 4

6.4.1 Cont.

Figura 6.4.3

Iconos y controles de la
herramienta Nivel de la ventana
y contraste

Figura 6.4.4

Ejemplo de inversion con la
herramienta Nivel de la ventana
y contraste
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SECCION
Software
Vision

Ajuste del zoom dindmico 6.4.1 Cont.

El icono Zoom Tool (Herramienta Zoom), Figura 6.4.5, abrira la herramienta de ajuste del
zoom. Después de abrir esta herramienta, el usuario podra utilizar la barra deslizante para
ajustar el nivel del zoom o hacer clic en los botones Fit to Specimen (Ajustar al espécimen),
Fit to Screen (Ajustar a la pantalla) o Zoom 1.0x (resolucién completa). Véase la Figura 6.4.6.
Para navegar por toda la imagen, cuando esta haya sido ampliada, sera necesario realizar una
panoramica. Aparecera un cuadro de dialogo en miniatura en la esquina superior izquierda de
la pantalla. Véase la Figura 6.4.7 siguiente. Para mover la imagen en la pantalla principal, haga
clic y mantenga presionado el boton izquierdo sobre la imagen, y mueva el raton.

Tenga en cuenta que, tradicionalmente, esta funcién también se denomina «Vista panoramica»
0 «Pan and Scan».
Figura 6.4.5
Icono de la herramienta Zoom

* Figura 6.4.6
ZOOM LEVEL Herramienta de ajuste del nivel
de zoom
= i
o Figura 6.4.7
e Ejemplo de vista panoramica
o (izquierda)
:— 1.00x
— 0.10x
Para asegurarse de que el espécimen esté a la vista, el botén Fit to 1.06
Specimen (Ajustar al espécimen) intentara detectar y ampliar el -
s . 2 . . 2 - |
espécimen. Si no se detecta un espécimen, este se ajustara por defecto
al modo anterior (ya sea «Fit to Screen» [Ajustar a la pantalla] o «Zoom
l.OX»). [ = |
Fit to Screen (Ajustar a la pantalla) ajustara la imagen a la pantalla.  EEEE——
Tradicionalmente, Zoom 1.0x se denomina «resolucion completa»,
ya que lleva la imagen a una vista 1-1 con la resolucién del monitor.
Annotations (Anotaciones)
El boton mostrado en la Figura 6.4.8 abrird las herramientas de anotacion. Figura 6.4.8

Estas herramientas y sus numerosas funciones se tratan con mas detalle en la Icono de Anotaciones

Seccién 6.8.0.
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SECCION

Software
Vision
PACS Store (Almacenar en SACI) 6.4.1 Cont.

El boton mostrado en la Figura 6.4.9 solamente funcionara cuando el sistema esté Figura 6.4.9

instalado en un centro médico con una red SACI. Para guardar sus archivos ﬂ Icono de Guardar en SACI

localmente, consulte la seccién 6.7.0.

PACS Print (Impresién en SACI)

Figura 6.4.10

El botén mostrado en la Figura 6.4.10 solamente funcionara cuando el sistema esté
instalado en un centro médico con una red SACI. Para efectuar la impresion local, %
consulte la seccién 6.7.0.

Icono de Impresion en SACI

Panel de control del dispositivo

El botén mostrado en la Figura 6.4.11 abrira el panel de control del dispositivo, lo Figura 6.4.11
que ofrecera al usuario del dispositivo la oportunidad de controlar el sistema de Icono del Panel de control del

rayos X mediante el software. El usuario podra seleccionar faciimente el modo de dispositivo
exposicion, el ajuste de kV del tubo de rayos X, el tiempo de exposicién y el nimero
de imagenes que deberan obtenerse para el promediado de las imagenes (si lo desea), asi
como iniciar la exposicién a los rayos X.
Figura 6.4.12

NOTA: el estado o la disponibilidad de los ajustes de la Panel de control del dispositivo
exposicion se indica mediante las flechas arriba y abajo
adyacentes al ajuste. Las flechas seran blancas para O Full Auto QO Auto kv

los ajustes activos y celestes para los inactivos. Los O Auto Time @ Full Manual
ajustes de la exposicion que estén activos dependeran

del modo de exposicién seleccionado.

La Figura 6.4.12 de la derecha muestra que se ha
seleccionado el modo manual completo y que los
promedios de kV, tiempo e imagen estan todos activos.
El usuario podra ajustar cada una de estas
configuraciones.

Tenga en cuenta que, en el sistema Faxitron Core, la
configuracion de mA no se puede ajustar utilizando el
software y siempre estara inactivo.

Image Averages

Cuando termine, haga clic en el botén Request X-Rays
(Solicitar rayos X) para adquirir una imagen o en el Request X-Rays
botén Set (Ajustar) para guardar la configuracion y
cerrar el panel de control del dispositivo.

Cancel
Si se hace clic en el botén Cancel (Cancelar), el panel
de control del dispositivo se cerrara sin guardar ninguno
de los cambios.
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SECCION

Software
Vision
Back to Procedure (Volver al procedimiento) 6.4.1 Cont.
El botdon mostrado en la Figura 6.4.13 cierra el modo de obtencién de imagenes y Figura 6.4.13

regresa a la pantalla del Home Menu (Menu de inicio). <

Apagado

El boton mostrado en la Figura 6.4.14 cierra el software y apaga el ordenador.

O

Notas de dialogo adicionales

Cuando se abre un didlogo, este se «acopla» a la izquierda de la pantalla. Si un usuario desea
desacoplar el cuadro de didlogo, podra hacer clic en el icono de «anclaje» superior derecho
para desacoplar el cuadro de dialogo y poder arrastrarlo libremente. El «anclaje» se convertira
luego en un icono «X», que permitira el cierre rapido.

Los usuarios también pueden navegar rapidamente entre los distintos dialogos haciendo clic
en el menu de la izquierda. Al hacerlo, el menu de la izquierda se cerrara rapidamente y abrira
los cuadros de dialogo correspondientes, segln sea necesario.

Barra de menu superior

El software permite acceder a los menus «View» (Ver), «Tools» (Herramientas), «Image Tools»
(Herramientas de imagen), «DICOM Utilities» (Utilidades de DICOM) y «Help» (Ayuda)
mediante una barra de menus superior. Véase la Figura 6.4.15. La barra de menu superior esta
oculta de forma predeterminada y se muestra haciendo clic en el botén de flecha ubicado en
la esquina superior derecha de la pantalla. Véase la Figura 6.4.16. El botén de flecha sera
blanco o negro, dependiendo de la pagina del software o el fondo de pantalla. Cada elemento
del menu se tratara en detalle en las paginas siguientes.

File Edit View Tools

Image Tools DICOM Utilities Help

A

Nota: La flecha apuntara hacia abajo cuando la barra de menu
superior esté oculta y, hacia arriba, cuando esta se muestre.

Menu View (Ver)

El menu «View» (Ver) se encuentra en el menu principal superior y contiene los elementos del
submend mostrados en la Figura 6.4.17 siguiente. Cada una de estas opciones se describira
con mas detalle en las proximas péaginas.

[ Tools Image Tools DICOM Utilities  Help

Zoom Mode 3 NORMAL (FULL RES.)
Image Averages ADJUST ZOOM
Image Perspective FIT TO SAMPLE

Grid Options v || FITALL

User Window Levels FIT WIDTH

Default Window Level FIT HEIGHT

Default Aspect for Raw Files
Enhanced Image
Sample Viewer

Magnifier Size

*r v ¥ ¥ v v v v v v

Review Layout

Icono de regreso al men(
de inicio

Figura 6.4.14
Icono de apagado del sistema

6.4.2
Barra de menu
superior

Figura 6.4.15
Barra de men( superior

Figura 6.4.16
Botones de la barra de men(
superior

6.4.3
Menu View (Ver)

Figura 6.4.17
Menu View (Ver)
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SECCION

Software
Vision
Modo Zoom 6.4.3 Cont.
Normal

Muestra la imagen obtenida en su formato original. El formato nativo de la imagen de Faxitron
Core se ajusta al area de visualizaciéon del monitor. El usuario puede ampliar la imagen si lo
desea. Consulte Ajuste del zoom dindmico en la Seccién 6.4.1.

Adjust Zoom (Ajustar el zoom)

Esta opcion esta desactivada y no esta disponible en este momento.

Fit to Sample (Ajustar al espécimen)

Esta opcion adapta la imagen obtenida para que se ajuste mejor a la muestra de especimenes
dentro del &rea de visualizacion del monitor.

Fit All (Ajustar todos)

Esta opcién muestra toda la imagen obtenida, independientemente de cual sea su formato
original. La opcion Full Resolution (Resolucidon completa) no funciona en este modo de vista.

Fit Width (Ajustar anchura)

Esta opcidon muestra la imagen obtenida a lo largo del ancho disponible de toda el area de
visualizacion.

Ajustar altura (Ajustar altura)

Esta opcién muestra la imagen obtenida a lo largo de la altura disponible de toda el area de
visualizacion.

Image Averages (Promedios entre las imagenes)

Esta opcién permite al usuario ajustar el nimero de promedios entre las imagenes que se
tomaran por cada exposicion. Las opciones disponibles son las tomas 1x, 2x, 4x u 8x. El ajuste
predeterminado es la toma 1x. Si el usuario selecciona 2, 4 u 8 tomas, el software obtendra el
numero de imagenes seleccionadas una detras de otra pulsando el botén Start (Comenzar)
una sola vez y promediara esas imagenes en una sola imagen.

Image Perspective (Perspectiva de la imagen)

Esta opcion permite al usuario rotar la imagen visualizada a una orientacion de 0, 90, 180 y
270 grados.
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SECCION

Software
Vision
Grid Options (Opciones de cuadricula) 6.4.3 Cont.
Cuando se muestra una imagen, ya sea como una imagen obtenida o una imagen recuperada
de la base de datos, el usuario podra activar una cuadricula. También permite al usuario
establecer el espaciado (anchura) de la cuadricula. Véase el ejemplo siguiente.
! Figura 6.4.18
Visualizacion de la cuadricula de
la muestra

User Window Levels (Niveles de la ventana de usuario)

Esto permite al usuario definir hasta tres (3) niveles de la ventana (WL) prefijados y establecidos
por el usuario. En primer lugar, seleccione el botén Window Level (Nivel de la ventana) y ajuste
el WL al nivel deseado. En el menu «View» (Ver), seleccione «User Window Levels» (Niveles de
ventana de usuario). Seleccione «Record Current WL» (Registrar WL actual) como USUARIO
WL n.°1,n.°2o0n.3. El WL ajustado se guardara segln la opcion seleccionada previamente.

Default Window Level (Nivel predeterminado de la ventana)

El usuario tiene dos opciones de «Default Window Levels» (Niveles predeterminados de la
ventana) (WL): «Optimize for whole area» (Optimizar para toda el area), que ajusta el WL para
toda la imagen, u «Optimize for sample» (Optimizar para el espécimen), que ajusta el WL
solamente para el area del espécimen. Ademas, existe la opcion «Set Default Window Level»
(Establecer el nivel predeterminado de la ventana), que se utiliza también para todas las
imagenes obtenidas que se encuentran aqui. Esta establecera el nivel predeterminado de la
ventana en funcion de las estadisticas de la imagen y debera hacerse por separado para las
imagenes no mejoradas y las mejoradas.

Default Aspect of Raw Files
(Aspecto predeterminado de los archivos sin procesar)

Ayuda a importar y abrir archivos de imagenes previamente guardados con atributos de archivo
desconocidos o datos de imagenes binarios que no tienen ninguna informacién de encabezado.
Dado que el tamafio exacto del conjunto del generador de imagenes no esta disponible en el
encabezado del archivo de datos de imagen, se usaran las dimensiones del generador de
imagenes mas adecuadas para importar o abrir dichas imagenes en funcion de que el ancho
sea mayor o menor que la altura (informacién de aspecto predeterminada).

Enhance Image (same as the Enhance Image button)
(Mejorar laimagen [igual que el boton Mejorar la imagen])

Procesa la imagen actual del paciente y mejora la visualizacion del tejido situado cerca de la
periferia de la muestra.

Sample Viewer (Visor de muestras)

La vista de muestras alterna un visor de camara web para facilitar la alineaciéon de los
especimenes. No se puede afiadir una camara web al sistema Faxitron Core.
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SECCION
Software
Vision

Magnifier Size (Tamafio de la lupa)

Permite al usuario seleccionar el tamafio de la herramienta Magnifier (Lupa) (véase el menu
Image Tools [Herramientas de imagen]). Las opciones son «Small» (Pequefia), «Medium»
(Mediana) y «Large» (Grande).

Review Layout (Disposicion de larevision)

Ayuda al usuario a configurar multiples paneles de imagen en Review (Database) Mode (Modo
de revisién [de la base de datos]) del programa. Las opciones de disposicién disponibles son:
«(1 X 1) Single» (Simple), «(2 X 1) Double H» (Doble H), «(1 X 2) Double V» (Doble V), «(1 +
(2 X 1) Triple» y «(2 X 2) Quadruple» (Cuadruple). Durante la operacion con paneles multiples,
el usuario puede hacer clic una vez en el panel o la imagen deseada para realizar la seleccion
actual; el panel seleccionado actual tendra un borde rectangular verde alrededor. Las imagenes
incluidas en la vista de lista de la base de datos, o vista de miniaturas de la base de datos, se
abriran en el panel seleccionado actual cuando se haga doble clic sobre ellas. El usuario
también podra abrir las imagenes en los paneles deseados directamente desde el menl
contextual de las vistas de la base de datos mencionada. Después de activar el menu
contextual, el usuario podra seleccionar en los paneles listados bajo OPEN TO- (ABRIR
HACIA) que proporcionara los paneles disponibles para abrir la imagen (izquierda, derecha,
arriba, abajo, etc.).

Menu Tools (Herramientas)

El menu «Tools» (Herramientas) esta ubicado en la barra de menu superior, situada en la

esquina superior izquierda de la pantalla principal.
Image Tools DICOM Utilities  Help

Preferences
Service Mode
Service Tools

Save Reference Files

Advanced Tools 3 AUTO SAVE ON/OFF »
PROPERTIES EDGE SUPPRESSION »
TILE SUPPRESSION »

EDIT  Current Image Record
DELETE Current Image Record
ADD  Current Image Record

X-RAY Calibration/Exposure Setup
PRESHOT AEC Exposure Setup
IMAGE ENHANCEMENT Setup
CAPTURE Screen Shot JPG/BMP Login Utility
Cylic Autornated Acquisitions

OTHER ADVANCED User Tools 3

Save/Store current image 3

Print current image 4

Preferences (Preferencias)

El mena «Preferences» (Preferencias) abre una utilidad de gestion de la configuracion que
permite cambiar varias opciones o parametros.

NOTA: la herramienta «Preferences» (Preferencias) esta protegida mediante contrasefia y
solamente puede acceder a ella un representante autorizado del servicio técnico de Faxitron.

NOTA: cambiar los parametros de configuracién sin los conocimientos ni la autorizacion
pertinentes podra causar la pérdida de calidad de las imagenes, dafios en el sistema y
funcionamiento incorrecto del sistema.
Modo Service (Modo de mantenimiento)
El «Service Mode» (Modo de mantenimiento) esta protegido mediante contrasefia y lo activan
técnicos autorizados de Faxitron para resolver problemas.
Service Tools (Herramientas de mantenimiento)

«Service Tools» (Herramientas de mantenimiento) suelen aparecer sombreadas en gris.
Solamente se enciende cuando el sistema esta en «Service Mode» (Modo de mantenimiento).

6.4.3 Cont.

6.4.4
Men( Tools
(Herramientas)

Figura 6.4.19
MenU Herramientas
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SECCION
Software

Vision

Save Reference Files (Guardar archivos de referencia)

La opcién «Save Reference Files» (Guardar archivos de referencia) suele aparecer sombreada
en gris. Solamente se enciende cuando el sistema esta en «Service Mode» (Modo de
mantenimiento).

Advanced Tools Options (Opciones de herramientas avanzadas)

Las «Advanced Tools» (Herramientas avanzadas) ofrecen varias opciones para configurar
aspectos del software tales como el post-procesamiento y las opciones de configuracion.

Auto Save On/Off (Guardar el encendido y apagado automatico)

Cuando «Auto save» (Guardar automaticamente) estd «activado», todas las imagenes
obtenidas posteriormente se guardaran en la base de datos. Los archivos se escribiran en un
directorio de datos definido en el archivo de configuracion.

X-Ray Calibration/Exposure Set-up
(Calibracién de los rayos X/Configuracién de la exposicién)

Se encuentran en Advanced Tools (Herramientas avanzadas). «X-Ray Calibration/Exposure
Setup» (Calibracion de los rayos X/Configuracion de la exposicién) ayuda al usuario a
determinar el tiempo de exposicidon adecuado para un determinado ajuste de kV que obtenga
la mejor calidad de las imagenes. Consulte en la seccion 6.2.0 y la Figura 6.2.4 una descripcion
mas detallada.

Configuracién del CAE de la exposiciéon de unatoma previa

El sistema Faxitron Core utiliza el control automatico de la exposicion (CAE) para proporcionar
la mejor calidad posible de las imagenes pulsando el botdn Start X-Ray (Comenzar radiografia)
una sola vez. El software utilizara una exposiciéon de una Preshot (Toma previa) para calcular
los ajustes 6ptimos de la exposicidn en kV y tiempo. La toma previa es una exposicion breve a
los rayos X, normalmente de 2 a 3 segundos. El software analizara los resultados para
determinar el kV y el tiempo necesarios para producir la mejor calidad de las imagenes. La
exposicion al CAE de una toma previa se configura en fabrica y se activa de forma
predeterminada.

«Preshot AEC Exposure Setup» (Configuracion del CAE de la exposicion de una toma previa)
permite al usuario ajustar el sistema a determinados requisitos de obtencion de imagenes o
para compensar el envejecimiento del sistema.

Para acceder al cuadro de didlogo «Preshot AEC Exposure Setup» (Configuracion del CAE de
la exposicion de una toma previa), vaya a la barra de menu superior, seleccione «Tools»
(Herramientas), «Advanced Tools» (Herramientas avanzadas) y, a continuacion, «<PRESHOT
AEC Exposure Setup» (Configuracion del CAE de la exposicion de una toma previa). Véase la
Figura 6.4.19. Se abrira el cuadro de dialogo de configuraciéon del CAE de la toma previa
mostrado en la Figura 6.4.20.

6.4.4 Cont.
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SECCION

Software
Vision

Introduzca los valores de [Erenetacc seting === 6.4.4 Cont.
PRESHOT AEC (C'TE DE LA FRESHOT - AEC ON/OFF FRESHOT ANaALYSIS METHOD
TOMA PREVIA) en la ventana s Lomwcween Figura 6.4.20
que se muestra a la derecha. el e Configuracion del CAE de la
Para el ajuste de las tomas b bt L diiee st exposicion de una toma previa
previas, los ajustes mostrados DYYNAMIC PRESHOT PREFERENCES
reflejan un tiempo de exposicién PRESHOT KVDESIRED v [230
ple 23 _kV y2 segund_os con una PRESHOTTMEDESRED I§]  [Zm0
intensidad objetivo de
8000 UAD LOS USUariOS pueden PRESHOT COMBIMATION |[1]NDNE,DISCAF|D PRESHOT, SHOW AEC SHOT ALONE j
introducir los parametros de las
tomas previas solo cuando se EE
selecciona DYNAMIC METHOD T
(METODO DINAMICO) (en la
seccion PRESHOT ANALYSYS R
METHOD [METODO DE EXPOSURE TUMING METHOD
ANALISIS DE TOMAS & AUTOKV /AUTOTIME O AUTOKY/FHED TIME  © FIKED KV /ALTO TIME
PREVIAS]). La seleccion de
STATIC METHOD (METODO ) a9
ESTATK_:O) utilizara parém_etros THICKNESS /BEAM HARDENING /OVERELURN
predefinidos por  Faxiton | ¢ ALSIGMRENENR:  © ovmsommmmoreon

s 2 ’ . ENTER SOFT TISSUE EQUIVALENT * Preshot and AEC shot are
opcion de seleccionar los SHMPLE+TRAY THICKNESS 0] 0.00"=000cm e
ajustes de kV y tiempo de =
exposicion en la  seccion Té:s:;IDNETSEIHng;EAN * GENERAL RECOMMENDATION: Use
EXPOSURE TUNING METHOD INTENSITY UNDER SAMPLE [spL) | 80000 22.1?;;;,;*;225{3‘ fEdidsto
(METODO DE AJUSTE DE LA
EXPOSICION).
Para obtener unas imagenes
mas precisas, el usuario podra CANCEL
introducir el grosor de SOFT |
TISSUE (Sample) (TEJIDO
BLANDO [Muestra]) y TARGET INTENSITY (INTENSIDAD DEL OBJETIVO) en las UAD.
Nota: los valores mostrados estan dentro del rango tipico de un sistema Faxitron Core, pero
pueden variar.
Para el modo AUTOMATIC EXPOSURE CONTROL (CONTROL DE LA EXPOSICION
AUTOMATICA), pulse el boton Start (Comenzar) en el software Vision (0 en el panel de
control). Para crear una regién de interés (ROI) y obtener los parametros de exposicién para la
exposicion optima de la imagen, el software Vision realizara una toma previa (exposicion previa
a una dosis breve y baja) de la muestra.

Utilidad Login (Inicio de sesidn)

La utilidad Login (Inicio de sesion) )
esta en el mend «Advanced Tools» Figura 6.4.21

(Herramientas avanzadas) y permite Utilidad Login (Inicio de sesion)

al usuario configurar y activar la
autenticacién con contrasefia de

Current Pagsword:

inicio del software Vision. La NEW PASSWORD |

activacion de esta funcién es opcional CHNGE S

en el sistema Faxitron Core. Si el PASSWORD |

usuario activa la autenticacién con

COntI’aseﬁa, sele ped”‘é la contrasefia 'SgH‘DENNTIMTE W ‘Enforce User Authentication on S oftware Startup

cada vez que abra el programa. Si no
se introduce la contrasefia correcta, el
programa se cerrara.

Apply Changes
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Properties (Propiedades)
«Properties» (Propiedades) oculta o muestra el cuadro de informacion de la imagen. Véase la
Figura 6.3.9.
Edit Current Image Record (Editar el registro de imagen actual)

Actualmente no se utiliza.

Delete Current Image Record (Eliminar registro de imagen actual)

Elimina la imagen actual del directorio de archivos, tal y como se especifica en el archivo de
configuracion.

Add Current Image Record (Agregar registro de la imagen actual)

Afiade la imagen actual al directorio de archivos, tal y como se especifica en el archivo de
configuracion.

Capture Screen Shot JPG/BMP
(Realizar captura de pantalla en JPG/BMP)

Seleccionando esta opcion del mend, el usuario puede realizar una captura de pantalla de la
ventana activa mostrada. El usuario puede especificar un nombre de archivo y elegir entre JPG
y BMP como formato de archivo guardado.

Save / Store Current Image
(Guardar o almacenar la imagen actual)

El usuario puede «navegar» hasta el directorio o la carpeta de archivos en la que desee guardar
la imagen. Debera asignarse un nombre de fichero en el campo proporcionado. El usuario
puede guardar la imagen como un tipo de archivo BMP, JPEG, TIF, RAW o DICOM. Para
guardar el archivo en formato DICOM, consulte la seccién «DICOM Functionality»
(Funcionalidad DICOM).

Print Current Image (Imprimir imagen actual)

Imprime la imagen actual en la impresora de Windows.

Image Tools (Herramientas de imagen)

Para editar la imagen obtenida o recuperada, estan
disponibles las siguientes funciones haciendo clic en el
menl «Image Tools» (Herramientas de imagen). Véase la
Figura 6.4.22. Con un solo clic del ratén sobre la opcion
deseada, se podra acceder a o activar las opciones del
submend.

IGELREGTIEE DICOM Liilities

Original Contrast
Invert

Magnifier
Enhance

ROI Contrast

ROI Window Level
Ruler

ROI Statistics

ROI Histogram
ROI Profile

Line Profile

6.4.4 Cont.

6.4.5

Image Tools
(Herramientas de
imagen)

Figura 6.4.22
Menu Herramientas de imagen
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Original Contrast (Contraste original)

«QOriginal Contrast» (Contraste original) restaura los niveles de contraste de laimagen. Esto sirve
para el mismo proposito que el botdn Original Contrast (Contraste original) en la herramienta
Window Level and Contrast (Nivel de la ventana y contraste). Véanse la Seccion 6.4.1 y la
Figura 6.4.3.

Invert (Invertir)

«Invert» (Invertir) hace que la imagen visualizada se invierta o revierta. Al invertir una imagen,
se invierte su transparencia: lo que es negro se convierte en blanco y lo que es blanco se
convierte en negro. A los grises se les asigna su transparencia espejo. Para desactivar la
funcion, haga clic de nuevo en «Invert» (Invertir). Realiza la misma funcién que el botén Invert
(Invertir). Consulte la Seccion 6.4.1y las Figuras 6.4.3y 6.4.4.

Ampliar

«Magnify» (Ampliar) permite al usuario ampliar un area de interés. Para utilizar la funcion
Magnify (Ampliar), sitte el cursor del ratén sobre el area que desee ampliar y haga clic con el
botdn izquierdo del ratén. Se ampliara el area de interés. Para desactivar la funcion, haga clic
de nuevo en «Magnify» (Ampliar). Consulte la Figura 6.4.23. El usuario podra ajustar el tamafio
del area de interés ampliada. Consulte el submenu «Magnifier Size» (Tamafio de la lupa) en la
Seccion 6.4.3.

Edge Enhance (Realce de los bordes)

«Edge Enhance» (Realce de los bordes) definira con mayor nitidez los bordes de las regiones
utilizando una diferencia de contraste. Puede que el realce de los bordes amplifique el ruido en
las imagenes en general. Seleccionando de nuevo la opcién del mend, se desactivara el realce
de bordes. Si hace clic en «Original Contrast» (Contraste original), la imagen volvera a su
estado original. Tenga en cuenta que esta es una funcion diferente a la funcién Enhance Image
(Mejorar la imagen) de las Secciones 6.4.1y 6.4.3.

ROI Contrast (Contraste de la ROI)

«ROI Contrast» (Contraste de la ROI) optimizara los niveles de contraste del interior de una
region de interés (ROI) definida por el usuario. Después de seleccionar «ROI Contrast»
(Contraste de la ROI), haga clic y mantenga pulsado el boton izquierdo del ratén en el punto
inicial de la ROI deseada, arrastre el ratén y suelte el botdn del raton en el punto final de la ROI
deseada. El contraste se ajustara automaticamente a los mejores niveles para esa ROI.

ROI Window Level (Nivel de ventana de la ROI)

La funcion «ROI Window Level» (Nivel de ventana de la ROI) no esta disponible en la version
actual del software Vision.

6.4.5 Cont.

Figura 6.4.23

Ampliar
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Regla 6.4.5 Cont.

«Ruler» (Regla) permite al usuario medir la distancia entre dos puntos de la imagen visualizada.

Las medidas de longitud se expresan en milimetros (mm). Después de seleccionar «Ruler»

(Regla), haga clic y mantenga pulsado el botén izquierdo del ratén y, empezando por el punto

inicial de la medicién, arrastre el raton y suelte el botdn del raton en el punto final de la medicion.

En la imagen, la regla tiene el aspecto de una linea roja.

L Figura 6.4.24

La medicién (en mm) se muestra Regla

al final de la Regla. Hasta que el

usuario seleccione otra

herramienta de imagen o hasta

que se realice otra accion, laregla

permanecera activa. Véase la

Figura 6.4.24. Para desactivar la

funcion, haga clic de nuevo en

«Ruler» (Regla).

Sugerencia: para obtener una

regla perfectamente horizontal,

vertical o de 45 grados, mantenga

pulsada la tecla SHIFT (del

teclado) mientras  mantiene

pulsado el botén izquierdo del

raton y arrastre.

Estadisticas de la ROI

«ROI Statistics» (Estadisticas de la ROI) mostrard un cuadro de didlogo que contiene

estadisticas de la imagen. Haga clic y mantenga presionado el botén izquierdo del ratén sobre

la region de interés (ROI) de la imagen principal, arrastre el cursor para hacer la seleccion

alrededor del area y luego suelte el botdn del ratén. La informacion estadistica de la region

seleccionada se mostrara en el lado izquierdo del cuadro de didlogo y la de toda la imagen, en

el lado derecho del recuadro. Las estadisticas que se muestran son: los puntos inicial y final de

la ROI, los valores de intensidad Minimum (Minimo), Maximum (Maximo) y Mean (Medio) y

Standard Deviation (Desviacion estandar) (STD). Para cerrar el cuadro de informacion Statistics

(Estadistica), simplemente haga clic en el boton Close (Cerrar). Véase la Figura 6.4.25. Para

desactivar la funcién, haga clic de nuevo en «ROI Statistics» (Estadisticas de la ROI).
Figura 6.4.25

Estadisticas de la ROI

Selected Region Whole Image

(T op.Left)=(559.1939) [TapLeft)=(0,0)
[Battom Right=[1189,2558) [Buttom Right}=(3072,3859)

Mirimurn: 516 Minimum: 523

W aimurn: 7537 P awimur: 14042
Mean:5620.00 Mean: 3606.26
STD: 955.60 STO:4026.28
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Histograma de la ROI 6.4.5 Cont.

«ROI Histogram» (Histograma de la ROI) creara un histograma para una ROI definida por el
usuario. Después de seleccionar la opcion del mend, coloque el cursor del ratén en laimagen
visualizada, mantenga pulsado el botdn izquierdo del raton y arrastrelo para seleccionar la
ROI deseada. Suelte el boton del ratdon. Se mostraran histogramas de la ROI seleccionada.
Véase la Figura 6.4.26.

La curva negra es el histograma de la region seleccionada. La curva azul es el histograma
de toda la imagen. Ambas curvas se normalizan contra el valor maximo de pixeles de la
region de interés seleccionada. Para desactivar la funcion, haga clic de nuevo en «ROI
Histogram» (Histograma de la ROI).

Figura 6.4.26
Histograma de la ROI

Histogram
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Perfil de la ROI

«ROI Profile» (Perfil de la ROI) creara un perfil para una ROI definida por el usuario. Después
de seleccionar la opcion del mend, coloque el cursor en la imagen visualizada. Para dibujar
un cuadro definido por el usuario alrededor de la ROl deseada, mantenga pulsado el botdn
izquierdo del ratén y mueva el cursor por la imagen. Suelte el botén izquierdo del raton
y aparecera un perfil que mostrara los valores de cada pixel de la ROI definida. Véase la
Figura 6.4.27. Por defecto, la direccidn de la promediacion de la ROI seleccionada es el eje
corto. El eje puede desplazarse hacia adelante y hacia atras seleccionando el botén
SWITCH, HOR<->VERT (CAMBIAR HORIZONTAL<->VERTICAL). Para desactivar la
funcién, haga clic de nuevo en «ROI Profile» (Perfil de la ROI).

Figura 6.4.27
Perfil de la ROI
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Perfil de la linea

«Line Profile» (Perfil de la linea) mostrara el perfil de una linea definida por el usuario.
Después de seleccionar «Line Profile» (Perfil de la linea), coloque el cursor en la imagen
visualizada. Para dibujar una linea definida por el usuario, mantenga pulsado el botén
izquierdo del ratén y mueva el cursor por la imagen. Suelte el botén izquierdo del ratén y
aparecera un perfil que mostrara los valores de cada pixel de la linea definida. Véase la
Figura 6.4.28. Por defecto, el primer punto seleccionado es siempre la parte izquierda (mas
cercana al origen) del gréafico (es decir, el eje horizontal del grafico puede tener indices de
pixeles (i, j) crecientes o decrecientes, dependiendo de los puntos inicial o final que se hayan
seleccionado). Para desactivar la funcién, haga clic de nuevo en «Line Profile» (Perfil de la
linea).

Graph Dialog

I Line Profile
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3] ] ~

1200
600.0
7200
1080.0
1200.0

=
©
@ >

Index on the Line From Point (2235 861) To (3362 858)

savess Tr|  PRINT | [ CLOSE

Built-In Window Level (Nivel de ventana incorporado)

El software Vision viene con una funciéon de Window Level (Nivel de ventana) «incorporado».
Para seleccionarlo, no hay ningin botén ni elemento del mend. La funcion Window Level
(Nivel de ventana) se activa automaticamente cada vez que se obtiene una imagen o se
recupera de la base de datos para revisarla. Esta funcion permite al usuario ajustar los
niveles de contraste y brillo de la imagen utilizando el ratén o el cursor.

Para ver los niveles de brillo u oscuridad, haga clic y mantenga pulsado el botén izquierdo
del raton sobre la imagen visualizada y mueva el cursor hacia arriba y hacia abajo. O mueva
el cursor hacia la izquierda y hacia la derecha para obtener un contraste alto o bajo. Mueva
el cursor hasta que la imagen se encuentre en los niveles deseados.

6.4.5 Cont.

Figura 6.4.28
Perfil de la linea
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Presionando el boton mostrado en la Figura 6.5.1 y ubicado en la parte inferior de la ventana 6.5.0
de obtencion de imagenes, aparecera la secuencia de imagenes en miniatura del paciente
actual. Véase la Figura 6.5.2.

Explorador de
imagenes del
paciente actual
Figura 6.5.1
N\ Icono del explorador de
s imagenes del paciente actual
Figura 6.5.2

Explorador de imagenes del
paciente actual

OPEN DATABASE

Figura 6.5.3
SRR Boton de la base de datos de

las imagenes

En texto naranja y a lo largo de la parte superior, la secuencia de miniaturas mostrara la
fecha en la que se realiz6 el procedimiento de cada serie de imagenes individuales.

Se iluminara en verde la imagen actual que aparece mostrada en la ventana de obtencion
de imagenes.

Para colocar las imagenes en la pantalla 0 en los paneles de revisién, la secuencia de
miniaturas permite realizar las operaciones «arrastrar» y «soltar», seglin sea necesario.

Ademas, con un solo clic, el usuario podra seleccionar varias imagenes y, a continuacion,
seleccionar entre las diferentes opciones para guardar las imagenes en una unidad USB,
enviar las imagenes al SACI o borrar las imagenes. Las imagenes seleccionadas apareceran
resaltadas en naranja.

Hay flechas situadas a la izquierda y a la derecha. En caso de que se tomen gran cantidad
de imagenes, pulsando las flechas izquierda o derecha el usuario podra recorrer por fecha
ascendente las imagenes tomadas.

También hay una opcion disponible para Open the Database (Abrir la base de datos) (véase
la Figura 6.5.3), que entra en el modo Review (Revision). Este mismo botdn es el equivalente
a pulsar Review Mode (Modo de revisién) en Home Menu (Menu de inicio). Véanse las
Figuras 6.0.1y 6.6.1.
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Se puede entrar en el modo de revision haciendo clic en el botén Review (Revisar) de la 6.6.0

pagina Home Menu (Menu de inicio), Figuras 6.6.1 y 6.0.1, o en el boton Open Database

(Abrir base de datos) de Current Image Browser (Explorador de Base de datos

imagenes actuales). Véase la Figura 6.5.3 anterior. Al hacer clic en —_ Figura 6.6.1

cualquiera de estos botones, se abrira la base de datos como se muestra > Icono del modo de revision

en la Figura 6.6.2. Mientras esté en modo de revision, el sistema estara que aparece en el mend

en modo de espera. Review de inicio

La base de datos se compone basicamente de tres secciones o subventanas. La seccién

Patient List Table (Tabla de la lista de pacientes) en la parte superior, la seccién Procedure

List Table (Tabla de la lista de procedimientos) en el centro y la seccién Image Thumbnail

List/Viewer (Lista/Visor de imagenes en miniatura) en la parte inferior. Figura 6.6.2

CLOSE DATABASE ADDITIONAL OPTIONS Ba/se de datos de |as

imagenes

ocified W
JAN 2 03/27 10:45:40
JENN /03/ 144 1930/03/03

(JANE

P201903271... 946130 2019/03/27 10..

120180327104306.0CM

P20190327104029

2018/03/27 10:43:06 Wednesday

120190327104230.0CM

P20190327 104029
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Como indica la flecha, las tablas de listas funcionan en una jerarquia de arriba hacia abajo: 6.6.0 Cont.

The Patient List (Lista de pacientes) ---> Procedure List (Lista de procedimientos) ---> Image
Thumbnail List/Viewer (Lista/Visor de imagenes en miniatura).

Cuando se selecciona un campo Patient (Paciente), se activa la ventana Procedure
(Procedimiento). La ventana Procedure (Procedimiento) muestra una lista de todos los
procedimientos realizados en el paciente seleccionado. Ademas, todas las imagenes
correspondientes al paciente se mostraran en la parte inferior derecha.

Cuando se selecciona un procedimiento, la lista de imagenes en miniatura/visor se filtrara para
mostrar solamente las imagenes que corresponden al procedimiento seleccionado. Se pueden
seleccionar varios procedimientos manteniendo pulsada la tecla Mayusculas y haciendo clic
con el boton izquierdo del raton en cada procedimiento. Se mostraran las imagenes
correspondientes de los procedimientos seleccionados.

Puede ajustarse la eleccién en la base de datos haciendo clic en los campos superiores, como
Patient ID (ID de paciente) y Last Name (Apellido), para ordenarla por uno u otro campo.
Cuando se haga clic con el cursor del ratén sobre uno de los campos de la base de datos, se
mostrara un pequefio indicador de flecha dentro del campo. Usando el boton izquierdo del
ratén y seleccionando el campo de nuevo, la flecha cambiara de ascendente a descendente o
viceversa. El campo seleccionado correspondiente se ordenara automaticamente.

Para facilitar la navegacion, hay barras de desplazamiento en la base de datos.

Para afiadir automaticamente la imagen a un panel de revisién, la lista de miniaturas/visor
permite al usuario hacer clic en el simbolo «+». Un usuario puede afiadir hasta cuatro
imagenes en los paneles de revisién. Los paneles de revisidn se ajustaran automaticamente
para abarcar las cuatro imagenes.

Todas las opciones del Current Patient Images Browser (Explorador de imagenes del paciente
actual) (véase la Figura 6.5.2) estan también disponibles en la parte superior de la pagina
Database (Base de datos). Ademas, en la Seccién 6.6.1 se describen opciones adicionales.

Nota importante: las imagenes en miniatura (.PNG) son archivos independientes de los
archivos de datos de imagen reales (DCM, DAT, DMM o RAW). Tienen el mismo nombre de
archivo que el archivo de imagen, pero tienen una extension de archivo (.PNG). Es posible
tener un archivo de imagen sin «miniatura». En ese caso, Vision intentara crear una miniatura
automaticamente para que la imagen se cargue en la base de datos. Sin embargo, si esto no
se pudiera hacer, la imagen no se mostrara.

Save Image(s) (Guardar imagenes)

El boton Save Image(s) (Guardar imagenes) aparece al seleccionar una entrada de Image
Table (Tabla de imagenes) o Thumbnail List (Lista de imagenes en miniatura), o en las
imagenes del paciente actuales; de lo contrario, se desactivara. La imagen seleccionada se
podra guardar en los siguientes formatos de imagen de 8 bits: JPEG, BMP, TIFF y RAW.
También se podra guardar en formato TIFF de 16 bits.

El nivel de ventana de la imagen guardada es el nivel de ventana predeterminado. Si el usuario
requiere que el nivel de la ventana esté organizado, debera cargar la imagen en Image View
(Vista de imagen) e imprimir desde alli, en lugar de imprimir desde el cuadro de dialogo de la
base de datos.

Send Image(s) to PACS (Enviar imagenes al SACI):

Esta funcion envia las imagenes a un servidor SACI de DICOM preconfigurado. Para obtener
mas informacién, consulte la Seccién 6.7.0.

6.6.1

Opciones
adicionales de la
base de datos

Funciones y herramientas del menu de la
base de datos o de imégenes

Hay funciones para explorar y buscar en la base de datos,
asi como para editar, borrar y afiadir registros a la base de
datos. Estas funciones se explican a lo largo de los
elementos del menu de la base de datos. Se accede a ellas Search
desde el boton de nivel superior denominado Additional Tools

Options (Opciones adicionales) dentro de la base de datos.

ADDITIONAL OPTIONS

Open
Print

View

Figura 6.6.3
Men( Opciones adicionales

Close Database
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Menu Open (Abrir) 6.6.1 Cont.

El mend «Openx» (Abrir) solamente tiene una opcién «Open Image from File» (Abrir imagen

desde archivo) que abre un cuadro de dialogo de Windows que permite al usuario navegar y

abrir archivos de imagen ubicados en unidades locales o de red.

Menu Print (Imprimir)
El ment «DB-Print» (Imprimir s Figura 6.6.4

Menu Impresion de la base

base de datos) ofrece la funcion
de datos

de impresion de imagenes,
procedimientos o pacientes.
Véase la Figura 6.6.4.

Open

Print Image to Local Printer :

Print Image(s) to DCM Printer View
Search
Tools

Close Database

Print Image to Local Printer (Imprimir imagen en laimpresora local)

«Print Image to Local Printer» (Imprimir imagen en la impresora local) esta disponible cuando
se selecciona la entrada en la tabla de imagenes o en la lista de imagenes en miniatura; de lo
contrario, estara desactivada. La imagen seleccionada se imprimira utilizando la impresora
local predeterminada del sistema Windows.

El nivel de ventana de la imagen impresa es el nivel de ventana predeterminado. No se
recomienda que los usuarios impriman desde este menU, a menos que estén satisfechos con
las impresiones establecidas en los niveles de ventana predeterminados y calculados por el
programa. El usuario podra cargar la imagen primero en la ventana Image View (Review) (Vista
de imagen [Revision]) y luego ajustar la imagen a los niveles de ventana deseados. Cuando
esté satisfecho con el nivel de la ventana, el usuario podra iniciar la impresion desde el meni
de la ventana de Image View (Vista de imagen). El cuadro de dialogo Format Options
(Opciones de formato) ofrece la posibilidad de elegir entre formatos de impresion.

Print Image(s) to DCM Printer
(Imprimir imagenes en una impresora DCM)

Esta funcion envia las imagenes a una impresora DICOM preconfigurada.

Menu View (Ver)
El mend «View» (Ver) ofrece al

Figura 6.6.5
que afectan a la vista de la base

de datos. Véase la Figura 6.6.5. Open
Print

Show All DB Entries
Refresh DB Entries Search
Browse Data Dir. (No DB) Tools

Browse Any Dir. (No DB)

Close Database

Show All DB Entries (Mostrar todas las entradas de la base de datos)

Recarga la tabla de pacientes desde el archivo de base de datos. Cualquier cambio o adicién a
la base de datos se aplicara a la tabla. Esta seleccion también borrara cualquier Search Filter
(Filtro de busqueda) activo que se haya aplicado a las tablas. Search Filter (Filtro de busqueda)
se explica a continuacién en detalle en el tema Database Search (Busqueda en la base de datos).

Refresh DB Entries (Actualizar entradas de la base de datos)

Actualiza la tabla Patient (Paciente), pero mantiene cualquier filtro de busqueda existente que
se haya aplicado.
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Browse Data Directory (No DB) (Explorar el directorio de datos
[no la base de datos])

Muestra todas las imagenes en miniatura en el directorio Data (Datos) establecido por el
archivo de configuracion. Estos archivos se muestran en el Visor de miniaturas. No estan
asociados a la base de datos ni a las listas de tablas. Esta herramienta es util para revisar
imagenes no grabadas o para depurar problemas de la base de datos con imagenes en el
directorio de datos actual.

Browse Any Directory (No DB) (Explorar cualquier directorio [no
la base de datos])

Permite al usuario navegar a cualquier directorio de archivos. Estos archivos se muestran en
el Visor de miniaturas. No estan asociados a la base de datos ni a las listas de tablas. Esta
herramienta es (til para revisar un directorio de imagenes, que nunca fue grabado en la base
de datos, o cuando los registros de la base de datos estan dafiados.

Search Menu (Menu de busqueda)

Las herramientas de «Search» (BlUsqueda) de la base de datos, véase la Figura 6.6.6,
proporcionan busquedas detalladas o filtrado de la base de datos. Seleccionando el menu
«DB-Search» (Busqueda en la base de datos) el usuario puede realizar una busqueda
detallada y especifica. Cuando se introducen y activan los criterios de busqueda en el cuadro
de dialogo de busqueda de la base de datos, véase la Figura 6.6.7, el filtro de busqueda se
aplicara a todas las tablas de listas del cuadro de didlogo de la base de datos de iméagenes. El
criterio de blsqueda activado se denomina

Search Filter (Filtro de busqueda) y este filtro
permanece efectivo hasta que el usuario
selecciona «Stop Search» (Detener blsqueda)
en el mend «DB-Search» (Busqueda en la

ADDITIONAL OPTIONS

Open
Print

base de datos) o «Show all DB Entries»
(Mostrar todas las entradas de la base de
datos) en el menu «DB-View» (Vista de la base
de datos). El filtro de busqueda activo siempre
se muestra en el titulo del cuadro de dialogo
Image Database (Base de datos de imagenes).

View
Start Search !
Stop Search Tools

Close Database

Start Search (Iniciar busqueda)

«Start Search» (Iniciar
basqueda) abre el
didlogo de busqueda de
la base de datos que
permite  al  usuario
colocar un FILTRO DE
BUSQUEDA activo en la
base de datos. Cuando
se abre el didlogo de —/7 11 717+ 72 00— — 0
blusqueda, se cierra la pagina Database (Base de datos) y el software vuelve a la pagina Image
Acquisition (Obtencién de imagenes). La pagina Database (Base de datos) se reabrira
automaticamente después de cerrar el cuadro de dialogo Search (Buscar).

Enter ACCESSION NUMBER

CLICK -0K--TO ACTIMATE SEARCH FILTER OM THE DATABASE

=]

SEARCH BY:

| [Accessiontumber]

Cancel I

Los menus desplegables proporcionan una lista de las categorias de busqueda. Seleccione
una categoria de blsqueda y escriba el parametro de busqueda deseado para iniciar la
blasqueda. Para iniciar la basqueda, seleccione «Start» (Comenzar). Si la categoria puede
tener mas de una entrada discreta, se mostraran todas las entradas de esa categoria.

Stop Search (Detener la busqueda)

«Stop Search» (Detener la busqueda) desactiva cualquier filtro de bldsqueda activo, borra todas
las tablas de la listay vuelve a cargar la lista de todos los pacientes a la tabla de lista de pacientes.

6.6.1 Co

Figura 6.6.6
MenU de busq
datos

Figura 6.6.7

nt.

ueda en la base de

Coémo iniciar una Blsqueda en la

base de datos
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Menu Tools (Herramientas) 6.6.1 Cont.
El menl «DB-Tools» ofrece funciones de imagen, procedimiento o paciente, asi como algunas
funciones utiles para reparar o reformatear la base de datos.
Figura 6.6.8

ADDITIONAL OPTIONS

Open
Print
View

Search

Edit Image Record

Add Record to DB o Eaabase

Import Records in DIR to DB
Reformat All DB

Edit Image Record (Editar registro de imagen)

La funcién «Edit Image Record» (Editar registro de imagen) no esta disponible actualmente en
el software Vision.

Add Record to DB (Afadir registro a la base de datos)

Disponible cuando se selecciona la entrada de Image Table (Tabla de imagenes) o de
Thumbnail List (Lista de imagenes en miniatura); de lo contrario, estara desactivada. Esto es
especialmente Util cuando se navega por un directorio sin que la base de datos tenga entradas
disponibles para las imagenes en ese directorio. El usuario puede seleccionar una sola imagen
de la lista de miniaturas y afadir registros de esa imagen a la base de datos. Si la entrada de
la base de datos ya existe para la imagen seleccionada, no causara ningin dafio; solamente
puede actualizar la base de datos en términos de dénde se encuentra actualmente el archivo
de imagen, es decir, el nombre del archivo/carpeta.

Import Records in DIR to DB (Importacién de registros del
directorio a la base de datos)

Esta herramienta ayuda a buscar y seleccionar una carpeta y, a continuacion, a rellenar la
base de datos con todas las entradas correspondientes para todos los archivos de imagen del
directorio seleccionado (incluidos los subdirectorios). Los formatos de las imagenes pueden
ser DCM, DAT, DMM y RAW. Si faltan miniaturas de imagenes, esta herramienta también
generara miniaturas de BMP en el mismo directorio.

Reformat All DB (Reformatear toda la base de datos)

La herramienta «Reformat All DB» (Reformatear toda la base de datos) ayuda a reformatear
los campos Date [YYYY/MM/DD] (Fecha [AAAA/MM/DD]), Date/Time [YYYY/MM/DD
HH:MM:SS] (Fecha/Hora [AAAA/MM/DD HH:MM:SS]) de las tablas, y también escribe en
mayusculas las letras de las entradas de algunos otros campos. Es una herramienta (til
cuando algun archivo de base de datos mas antiguo se importa y abre por primera vez, o
cuando el usuario altera manualmente las entradas de la base de datos utilizando MS Access.

Notas adicionales en la base de datos

e La posibilidad de salir de la base de datos, permaneciendo dentro del modo Revision,
se encuentra en Additional Options (Opciones adicionales).

¢ El boton de la parte superior izquierda se ajustara para llevar al usuario Back to Acquisition
(De vuelta a la obtencion), Back to the Main Menu (De vuelta al menu principal) o se convertira
en el botdn Close Database (Cerrar base de datos), dependiendo del flujo de trabajo utilizado
para entrar en la pantalla Database (Base de datos) y de lo que sea mas conveniente.

MenU Herramientas de la base

de datos
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Editar o eliminar de la base de datos la informacion sobre el paciente

El usuario puede editar o borrar la informacion sobre el paciente desde la base de datos. Para
abrir un cuadro de dialogo, haga clic con el botén derecho en la entrada del paciente situada
en la seccion superior de la base de datos. Véase la Figura 6.6.9.

1D6758 2019/03/7

D56 2019/03/2

ID8679 Edit Patient Information

Patient Name: t N JANE -
Patient ID: Ll JD8679
Date of Birth: 1920/03/23

Delete Patient Information

Al hacer clic en «Edit Patient Information» (Editar
informacion sobre el paciente), se abrira un
cuadro de didlogo «Patient Information» Save Changes >
(Informacién sobre el paciente). Véase la Figura
6.6.10. Para volver a la base de datos sin realizar
ni guardar los cambios, haga clic en Cancel (
(Cancelar). Al hacer clic en Save Changes
(Guardar cambios), se abrira un cuadro de dialogo de «Confirmation» (Confirmacién). Para
confirmar y continuar, haga clic en Yes (Si). Los cambios se guardaran y el usuario volvera a
la base de datos. No anulara los cambios y volvera a la base de datos. Cancel (Cancelar)
regresara al usuario al cuadro de dialogo «Patient Information» (Informacion sobre el paciente).

Nota: Si el sistema tiene activada una contrasefia de puesta en marcha (consulte el tema Utilidad
Inicio de sesién en la Seccion 6.4.4 y la Figura 6.4.21), se le pedira la misma contrasefia cuando
intente «Delete Patient Information» (Eliminar la informacién sobre el paciente) en la base de datos.

El estandar DICOM
¢, Qué es el estandar DICOM?

El Estandar de Imagenologia Digital y Comunicaciones en Medicina (DICOM) es una serie de
protocolos utilizados por equipos y software médicos para permitir que los datos sean
compatibles e intercambiables con otros equipos o software médicos.

Cuando se guarda un archivo en formato DICOM, se crea un archivo que incluye los datos
relevantes del paciente, el equipo de obtencidén de imagenes, los datos del hardware y los datos
de las imagenes, todo en un solo archivo. Ademas, el archivo guardado contiene caracteristicas
especificas identificadas por el ordenador y el software como archivo de estandar DICOM. Una
vez que una aplicacion de software reconoce el archivo como un archivo de estandar DICOM,
puede iniciar un lector DICOM y extraer los datos correctamente, independientemente del
origen del archivo.

Un archivo creado utilizando el protocolo DICOM tiene la siguiente estructura:

Preamble Header

Prefix

Data Elerment

Data Element

Data Element

Data Elerment Data Set

Data Elerment

Data Elerment

Cuando el preambulo consta de 128 bytes, todos ellos normalmente configurados en 00H, a
menos que no sean utilizados por un perfil de aplicacién o una implementacion especifica; el
prefijo consta de 4 bytes, que constituyen la cadena de caracteres «DICM» codificada como
caracteres en mayuscula del repertorio de caracteres 1SO 8859 GO; y los elementos de los
datos son arbitrariamente grandes (o pequefios) y contienen los datos.

6.6.1 Cont.

Figura 6.6.9
Cuadro de didlogo Editar/eliminar
(izquierda)

Figura 6.6.10
Informacion sobre el paciente
(derecha)

6.7.0
Funcionalidad
DICOM

Figura 6.7.1
Estructura del protocolo DICOM
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Modalidad 6.7.0 Cont.
Para acceder a la configuracién de la modalidad de los archivos DICOM, desde la barra de
menus superior, seleccione «DICOM Utilities» (Utilidades DICOM) y, a continuacién, «<DICOM
Modality Setup» (Configuracién de la modalidad DICOM). Figura 6.7.2

DICOM Utilities iRl

DICOM MODALITY Setup
DUMP DICOM Header

Es posible seleccionar el tipo de almacenamiento DICOM, ya sea Presentation (Presentacion)
o Processing (Procesamiento). EI mismo cuadro de didlogo permite seleccionar la modalidad
de imagen DICOM, ya sea Digital X-Ray (Radiografias digitales) o Digital X-Ray Mammography
(Mamografia digital de rayos X). El usuario no puede definir Transfer Syntax (Sintaxis de
transferencia) ni Value Representation (Representacion de valores). Siempre se asignan para
gue sean META HEADER PRESENT (con etiquetas meta en el encabezado), LITTLE_ENDIAN
(extremidad pequefia) y VR_IMPLICIT (realidad virtual implicita).

| Dicom File/Transfer Setting
DICOM Storage Type Yalue Representation

{* Storage For Presentation * Implicit

" Storage For Processing " Enplicit*

DICOM Image Modality Tranzfer Syntax

o Digital »-rap Image [General] # Littls Endian

(" Dugital ¥#-ray Mammaography [mage " Big Endian®

] IMPLICIT %R and LITTLE-EMDIAM syntax is recommended. Other options may
not be fully compatible with third party software or DICOM services. IMPLICIT-VR
and BIG-EMDIAN cannot be simultaneously selected.

Default DICOM Servers
STORE T |

STORE 2 |
¥ Enable Single-Click Auto Store

PRINT |
¥ Enable Single-Clhick Auto Print

ML |

¥ Enable Auta Search When Connecting to MWL Server
v Enable Single-Click Auto ML Connection

[ Autoclose dialog after 5 seconds of successful ansfer/printing,

Click DICOM Servers button to add, configure
DICOM Servers... | o delete DICOM servers.
(]S | Caticel

NOTA: cuando las modalidades DICOM se han seleccionado, permanecen en efecto incluso
después de que el software Vision se ha cerrado. Los ajustes de modalidad se
almacenaran y permaneceran en la forma configurada hasta que se cambien de nuevo
utilizando DICOM File Settings (Ajustes del archivo DICOM). Estos ajustes (Storage
Type & Modality, Transfer Syntax y Value Representation) (Tipo y modalidad de
almacenamiento, sintaxis de transferencia y representacion de valores) seran efectivos
para todas las funcionalidades DICOM Local Save (Almacenamiento local) o Print
(Impresion).

Men Utilidades de DICOM

Figura 6.7.3

Ajustes de la modalidad DICOM
Se muestran los ajustes
predeterminados
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Default DICOM Servers (Servidores DICOM predeterminados)

Esta seccion contiene la configuracion para los servidores DICOM predeterminados y para
automatizar algunos de los procesos al almacenar, imprimir o buscar servidores SACl y MWL.

Las casillas de verificacion «Enable Single-Click Auto Store» (Activar almacenamiento
automatico con un solo clic), «Print» (Imprimir) o kMWL Connection» (Conexién MWL) permiten
al usuario almacenar o imprimir imagenes, o0 conectarse automaticamente al servidor MWL. Si
usted utiliza un solo servidor SACI para esas acciones o la mayoria de su trabajo involucra un
solo servidor SACI, marque la casilla deseada para automatizar esas acciones.

«Enable Auto Search When Connecting to MWL Server» (Habilitar la busqueda automatica al
conectarse al servidor MWL) le indicard a la aplicacion que realice automaticamente una
busqueda con la configuracién de basqueda predeterminada al buscar los datos del paciente.

El cuadro de didlogo «Auto close dialog after N seconds of successful transfer/printing» (Cierre
automatico después de N segundos de transferencia o impresién correcta) cerrara
automaticamente el cuadro de didlogo DICOM Networking (Trabajo en red DICOM) transcurrido
un numero especificado de segundos. Si hubo un error en la transferencia o la impresion, el
didlogo no se cerrara automaticamente.

Al hacer clic en el boton DICOM Servers (Servidores DICOM), se abrira el cuadro de didlogo
DICOM Networking (Trabajo en red DICOM), donde el usuario podra afadir, modificar o
eliminar servidores DICOM. Véase la Figura 6.7.5.

DICOM Save Local (Guardar como DICOM local)

Para guardar la imagen actual en una unidad local o directorio, haga clic con el botén derecho
en cualquier parte de la imagen. Esto mostrara el cuadro de didlogo que se muestra en la
Figura 6.7.4 siguiente. Haga clic en «Save/Store current image» (Guardar/almacenar imagen
actual) y, a continuacion, en «As local DICOM image» (Como imagen DICOM local). Se abrira
el cuadro de didlogo Windows File

LI IETE CUITENT IMage recora

Save (Guardar archivo de Windows) Add new record

estandar. Busqu.e 0 haga clic en la Save/Store current image 4 LIS Archive image

carpeta o directorio deseado, : : - :
Print current image 3 As local DICOM image

introduzca el nombre del archivo y
haga clic en Save (Guardar).

As local image

Maore options...

PACS Store and PACS Print (Almacenamiento en SACl e
impresién en SACI)
El software Vision permite

el almacenamiento en SACI
(DICOM) y la impresion en

SESSION SECURITY VIEW COMMAND PREFERENCES

DICOM Network Connections

SAC' (D | Cp M) Estas ADD Session g g
opcmndes elstan f;jlsponleLes MODIFYSesson | |1 1 oico pon 1 BiEGH
en todo el software. or REMOVE Session

ejemplo, si se selecciona el T r—
botén PACS Store

(Almacenamiento en |[EECFEN

SACI), se podra mostrar la T

siguiente  ventana  de [

dialogo de conexiones de |

red DICOM. Este cuadro de

dialogo permite al usuario —_—

realizar un DICOM Store

(Almacenamiento en

DICOM), una DICOM Print e

(Impresion en DICOM) o
Add (Agregar), Modify (Modificar) o Remove DICOM Network connections (Eliminar conexiones
de red en DICOM) o Peripherals (Periféricos).

6.7.0 Cont.

Figura 6.7.4
Cuadro de didlogo Guardar
imagen actual

Figura 6.7.5
Cuadro de didlogo Conexiones de
red DICOM
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PACS DICOM Store (Almacenamiento en DICOM como SACI)

El software Vision es compatible con el servicio DICOM 3.0 C-STORE. Esto permite enviar una
imagen o una serie de imagenes (bajo un procedimiento especifico) a un sistema de
almacenamiento remoto compatible con la entidad de aplicacion DICOM (AE), como, por
ejemplo, SACI. Una vez mas, la capacidad DICOM Store (Almacenamiento en DICOM) esta
prevista en todo el software Vision. Las modificaciones de Presentation (Presentacion) y
Processing (Procesamiento) se pueden realizar a través de DICOM Modality Setup
(Configuracion de la modalidad DICOM) bajo el menua Tools (Herramientas).

Nota: en DICOM Store (Almacenar en DICOM), «SET FILM Attributes» (Ajustar atributos de la
pelicula) se muestran en gris.

El usuario puede afadir una nueva configuraciéon para una entidad de aplicacion (AE) de
DICOM remota a la que enviar la imagen o seleccionar una ya configurada, que se muestra en
las conexiones DICOM Network (Red de DICOM) en el cuadro de didlogo DICOM Networking
(Conexiones de red de DICOM). Haciendo doble clic (o un solo clic y presionando botén
Connect [Conectar]) en el icono de la entidad de aplicacién (AE) de DICOM remota, el software
Vision se conectara y establecera una asociacion DICOM con la AE remota seleccionada. Una
vez que la asociacién se haya establecido con éxito, la imagen se podra enviar para su
almacenamiento pulsando el boton Store (Almacenar). Después de seleccionar el boton Store
(Almacenar), el software Vision enviara la imagen seleccionada a la AE de DICOM remota
definida. Si la operacion de almacenamiento tiene éxito, la AE de DICOM remota enviara una
confirmacion de recepcién y almacenamiento de las imagenes. Si la operacién falla, la AE de
DICOM remota enviara un codigo de error indicando la razén del fallo.

Una sola imagen también puede ser enviada para su almacenamiento haciendo clic en el boton
derecho del raton sobre la imagen en «miniatura» mientras esta en el navegador de la base de
datos y siguiendo el mismo procedimiento descrito anteriormente. Es posible enviar una Series
(Procedure) (Serie [Procedimiento]) completa de imagenes para su almacenamiento. Esto se
logra haciendo clic en el boton derecho del ratén en el nombre de la Series (Procedure) (Serie
[Procedimiento]), que aparece en la pantalla del navegador de la base de datos y de nuevo,
siguiendo el mismo protocolo descrito anteriormente.

Add Session (Agregar sesion)

El botén Add Session (Agregar sesion) abre el cuadro de dialogo Session (Sesion) a través del
cual el usuario puede configurar una nueva conexion a una entidad de aplicacion DICOM remota.

Para crear una nueva configuracion de conexion a una AE de DICOM remota, el usuario debera
tener disponible la siguiente informacién: Application Entity Title (AE Title) (Titulo de la entidad
de aplicacion [titulo AE]), la eleccién de «function to perform» (Funcién que se va a realizar) de
DICOM/SACI, IP Address (direccion IP) y Port Number for the Sever (Nimero de puerto para
el servidor [es decir, la impresora DICOM o el sistema SACI]).

El titulo AE y el nimero de puerto del sistema del usuario (es decir, el cliente) también son
obligatorios. Para crear una nueva configuracion, rellene los campos de datos pertinentes y
seleccione OK (Aceptar).

Seleccién del comportamiento de la funcion de sesidn
predeterminada de DICOM/SACI

Actualmente existen cuatro (4) tipos de
funciones que una sesi6n DICOM puede
representar por defecto. Estos se encuentran en
la lista desplegable Function (Funcién) (cuadro
combinado) que se muestra en la Figura 6.7.6
siguiente. También hay una lista a continuacion:

1. Una conexiéon DICOM/SACI GENERAL

2.  Una conexion ALMACENAMIENTO EN
DICOM

3. Conexion de una IMPRESORA DICOM

4. Una conexion LISTA DE TRABAJO de
modalidad DICOM

6.7.0 Cont.

Figura 6.7.6

Cuadro de dialogo Propiedades

de la sesion
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El propdsito de la «funcién» DICOM es permitir la creacién de una sesién o conexion
(afiadida) que permita que un «dispositivo» DICOM/SACI solamente pueda ser utilizado, tal
y como el usuario lo ha configurado, para una categoria de funcién en particular. Una vez
configurado, al visualizar o utilizar «<DICOM Networking Dialog» (cuadro de didlogo
Conexiones de red de DICOM) (véase Figura 6.7.5), solamente estara «activo e iluminado»
el icono correspondiente a la funcién elegida. Es decir, tendra un color azul en lugar de un
color «grisaceo». Por ejemplo, en la Figura 6.7.5 hay tres (3) iconos que representan, en
orden: un almacenamiento en DICOM (DICOM Store 1), una impresion en SACI (DICOM
Print 1) y una lista de trabajo de modalidad (DICOM-MWL). Debido a que el icono DICOM
Store (Almacenamiento en DICOM) fue elegido previamente, es el Gnico que esta activo
(pantalla azul). Asimismo, funciona igual para los otros modos.

Modify Session (Modificar sesion)

El boton Modify Session (Modificar sesién) abre el cuadro de dialogo para la entidad de
aplicaciéon (AE) de DICOM seleccionada. En esta ventana, el usuario puede modificar la
informacién del servidor y del cliente descrita en la descripcion de Add Session (Agregar
sesion).

Remove Session (Eliminar sesion)

El boton Remove Session (Eliminar sesion) elimina la configuracion de la entidad de
aplicacién (AE) de DICOM seleccionada en el software Vision. Una vez eliminada, la
configuracion de la entidad de aplicacion (AE) de DICOM no se podréa restaurar, a menos
que el usuario vuelva a introducir manualmente los datos necesarios mediante el boton Add
Session (Agregar sesion). Se solicitara una confirmacién de la accién; véase mas adelante.

6.7.0 Cont.

Figura 6.7.7

Verificacion de la eliminacion
de una conexion de red
DICOM existente
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Association (Asociacion) 6.7.0 Cont.

El boton Association List (Lista de Asociaciones) abre el cuadro de didlogo Association

(Asociacion), representado abajo, mediante el cual el usuario puede editar los parametros y

protocolos utilizados por el software Vision cuando negocia una conexion con una entidad de

aplicacion (AE) de DICOM remota. Estas opciones solamente deben ser modificadas por un

usuario avanzado que esté familiarizado con los protocolos de asociacién de DICOM.

L, bicom association le3wf|  Figura6.7.8

Wersion:

—

|‘I .2.840.10008.2.1.1.1

16384 ¥ Enabled

Application Context: Cancel

[l ]

Max Data Length:

Implementation Class: |1.2.84D.11425?.1123455 v Enabled
Implemmentation Yersion: |'I v Enabled
tax Operation Invoked: -
Enabled
tax Operation Performed: 2
sl s Werification Clazz -

Select Al
4 Dezelect Al

b odify

o2 Default

Basic Film Session Class

m

Basic Film Box Clazz
Bazic Grayscale Image Box Class

Bazic Grayscale Print Management Meta Class
Print Job Clazz

Basic Annotation Box Clags

Printer Class

4

50000

Ll k

Timeaut [ms]:

Film Attributes (Atributos de la pelicula)

Al seleccionar «Set DICOM Print Film Attributes» (Ajustar atributos de la pelicula de la
impresora DICOM) en el ment «Command» (Comando) (Figura 6.7.9), aparecera el cuadro de
didlogo DICOM Printer Setup (Configuracion de la impresora DICOM). Véase la Figura 6.7.10.
En este cuadro de didlogo, el usuario podra seleccionar varias opciones que rigen el formato
de la pelicula y la impresion. Al seleccionar Default (Predeterminado), se restauran todas las
opciones predeterminadas. Las configuraciones de los ajustes se proporcionan a través de
menus desplegables. Para aceptar la configuracion modificada, seleccione OK (Aceptar). Para
rechazar las opciones y salir de la ventana sin realizar ninguna modificacion, seleccione Cancel
(Cancelar).

;"tlz__{, DICOM MNetworking Dialeg - Bioptics Vision
SESSIOM  SECURITY VIEW COMMAND PREFEREMCES
: ECHO ON/OFF
_ | CHECK ASSOC. FOR STORAGES
ADD Session |
MODIFY Session
I

REMOVE Session |
ASSOCIATION List |

DISCONNECT I
ECHO ON/OFF I

SELECT DICOM File & DICOM STORE

DICOM PRINT Selected \-
DICOM C-FIND Patient Root...

DICOM C-FIND Study Root...

DICOM C-FIND Patient/Study On

DICOM C-FIND Modality Workdist...

Ventana Asociacion DICOM

Figura 6.7.9
Establecer los atributos de la
pelicula de la impresora DICOM
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DICOM Printer Setup X
Figura 6.7.10
: Cuadro de didlogo Configuracion
Medium Type Sl % de la impresora DICOM
Print Priority |High ~|
Mumber of Copies |1 ﬂ
Film Destination |Magazine ﬂ
Filr Orientation |P0ﬁrﬁit ﬂ
Empty Image Density |El|ack ﬂ
Border Density |E|Iack ﬂ
Magnification Type | REPLICATE ~|
Film Size ID |BINX1QIN ~|
FPalarity |N0rmal ﬂ
Smoothing Type |Medium ﬂ
Film Density
Max Density  [415 ﬂ 3
Min Density |0 4 j
Image Display Format =
@ sTANDARDY  [1 ~| 1T ]
" Slide
Default Ok | Cancel

PACS Print (Impresion en SACI)

La opcion PACS Print (Impresiéon en SACI) envia la imagen seleccionada a la impresora SACI
DICOM seleccionada. La imagen se imprimira de acuerdo con las opciones de formato de
pelicula y de impresidon que se encuentran en el cuadro de dialogo Set Film Attributes
(Establecer atributos de pelicula) descrito anteriormente. Si el usuario inicia la impresion en
SACI desde Image View (Vista de imagen), el nivel de la ventana seré elegido desde la vista
de imagen. Si la impresién en SACI se inicia desde el dialogo de base de datos, el nivel de
ventana sera el nivel de ventana por defecto calculado por el software Vision.

Close (Cerrar)

El botén Close (Cerrar) cierra el cuadro de didlogo DICOM Networking (Conexiones de red de
DICOM) y devuelve al usuario al area desde la que se ejecut6 el comando DICOM. Este
comando también cerrard la conexién o asociacion entre el software Vision y el dispositivo
DICOM remoto si se ha establecido una conexion.
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Descripcion general

Las anotaciones de usuario dentro del software Vision de Faxitron permiten aplicar a una
imagen una «sobreimpresion» grafica transparente, cominmente llamada «anotaciones».
Estas anotaciones adoptan la forma de texto, lineas, lineas de «forma libre» (curvas de Bezier),
flechas, elipses y cuadros. Esto permite afiadir informacion adicional y «marcadores» a la
imagen, si se desea. Tenga en cuenta que todas las anotaciones se pueden activar o desactivar
facilmente; en otras palabras, se pueden mostrar u ocultar a voluntad.

Funcionamiento

Para comenzar a anotar, seleccione la herramienta Annotations (Anotaciones) del menu de la
izquierda. Véanse las Figuras 6.4.1y 6.8.1. Al abrir este cuadro de didlogo, el software pondra
inmediatamente al usuario en modo de disefio. También mostrar4 una «Tool Pallet»

(Paleta de herramientas). Véase la Figura 6.8.2 siguiente.

Al seleccionar Save (Guardar) o Cancel (Cancelar) en este cuadro de didlogo, se cancelaran
las anotaciones anteriores o se guardaran las anotaciones actuales en la ventana. También le
devolvera a usted al modo normal de obtencién de imagenes.

La paleta de herramientas consta de quince (15) opciones de herramientas que se muestran a
continuacién. Sin embargo, las herramientas pueden ser truncadas en funcién de las
necesidades del usuario a las 8 herramientas mas comunes, que se muestran en la fila superior
del cuadro de dialogo.

Tenga en cuenta que el comportamiento de la mayoria de estas opciones de herramientas
implica utilizar el ratén para guiar la posicion y la forma dinamica en pantalla. Los «clics» del
raton se utilizan para establecer la posicion y la forma definitivas.

El término «swipe» (deslizar) implica mantener pulsado el bot6n izquierdo del raton y mover el
objeto por la pantalla. Si se suelta el botdn izquierdo del ratébn o se hace clic con el botén
derecho del ratén, la anotacién se colocara en una posicion «permanente» o definitiva.

Mew Preset Mame Here

Add as Mew Preset

SAVE

A partir de la parte superior izquierda de la figura anterior, se mostrara una descripcion de cada
opcion de herramienta.

6.8.0
Anotaciones del
usuario

Figura 6.8.1
Disefio de anotaciones de usuario
Paleta de herramientas

Figura 6.8.2
Disefio de anotaciones de usuario
Paleta de herramientas
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10.

11.

12.

13.

14.

15.

Herramienta Selection (Seleccion): se utiliza para seleccionar (resaltar) un objeto de la
anotacion actual. Haga clic y mantenga pulsado el bot6n izquierdo del ratén, que establece
una posicién inicial y, a continuacion, mueva el raton. Cualesquiera que sean las
anotaciones que se encuentren dentro del cuadro que se estd mostrando, seran
seleccionadas para utilizarlas posteriormente. Para finalizar la operacion, suerte el botén
izquierdo del raton.

Herramienta Line (Linea): dibuja una linea recta con esta opcion. El comportamiento del
ratén es el mismo que el de arriba.

Herramienta Box (Cuadro): dibuja un cuadro. EI comportamiento del ratén es el mismo
que el de arriba.

Herramienta Ellipse (and Circle) (Elipse [y circulo]): dibuja una elipse o un circulo.
El comportamiento del ratén es el mismo que el de arriba.

Herramienta Arrow (Flecha): dibuja una linea con una flecha al final. EI comportamiento
del ratén es el mismo que el de la herramienta Line (Linea).

Herramienta Polygon Open Line (Linea abierta poligonal): dibuja lineas no rectas
«segmentadas y abiertas». Haga clic con el botén izquierdo del ratén, mantenga pulsado
el boton y dibujelo. Para fijar un segmento de linea, suelte el botdn izquierdo. Repitalo
cuantas veces lo desee. Haga clic con el botdén derecho del ratén y la operacién de la
herramienta habré finalizado.

Herramienta Text (Texto): crea un «cuadro de texto» donde se pueden escribir datos
basados en texto.

Herramienta Ruler (Regla): crea un segmento de lineas paralelas. Muy parecida a la
funcion Image Tools Ruler (Regla de herramientas de imagen).

Herramienta Polygon Closed Line (Linea cerrada poligonal): dibuja lineas no rectas
«segmentadas y cerradas». Haga clic con el botén izquierdo del raton, mantenga pulsado
el boton y dibujelo. Para fijar un segmento de linea, suelte el botén izquierdo. Repitalo
cuantas veces lo desee. Haga clic con el botén derecho del ratén y la operacién de la
herramienta habra finalizado.

Herramienta Curved Open Line (Linea curva abierta): dibuja lineas curvas «abiertas y
segmentadas» (Curvas de Bezier). Haga clic con el boton izquierdo del ratén, mantenga
pulsado el botén y dibljelo. Para fijar un segmento de linea curva, suelte el botén izquierdo.
Repitalo cuantas veces lo desee. Haga clic con el botén derecho del ratén y la operacion
de la herramienta habra finalizado.

Herramienta Curved Closed Line (Linea curva cerrada): dibuja lineas curvas
«segmentadas y cerradas» (Curvas de Bezier). Haga clic con el boton izquierdo del ratén,
mantenga pulsado el botdn y dibljelo. Para fijar un segmento de linea curva, suelte el
botén izquierdo. Repitalo cuantas veces lo desee. Haga clic con el botén derecho del ratén
y la operacion de la herramienta habra finalizado.

Herramienta Text «Balloon» (Globo de texto): crea un cuadro de texto con un segmento
de linea que sobresale de una esquina del cuadro de texto. Esto se puede utilizar para
«enlazar» texto a algo que esté en la imagen que usted haya obtenido.

Segmented Ruler (Regla segmentada): dibuja lineas no rectas paralelas «abiertas y
segmentadas». Haga clic con el boton izquierdo del raton, mantenga pulsado el botén y
dibljelo. Para establecer un segmento de lineas paralelas, suelte el boton izquierdo.
Repitalo cuantas veces lo desee. Haga clic con el botdn derecho del ratén y la operacion
de la herramienta habra finalizado. La longitud de todos los segmentos de lineas paralelas
se muestra al final de la regla. Util para una estimacion aproximada de la periferia de un
objeto o paciente.

Herramienta Protractor (Escuadra): dibuja un angulo en la pantalla y proporciona el
grado del angulo. Igual que una escuadra.

Herramienta Orthogonal Ruler (Regla ortogonal): proporciona dos (2) lineas
perpendiculares entre si.

6.8.0 Cont.
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Design Mode (Modo de disefio) y menu contextual del ratén 6.8.0 Cont.
En el modo de disefio de anotaciones de usuario, pero no en un modo de operacion especifico,
se puede hacer clic con el boton derecho del ratén y obtener un menud contextual. Véase mas
abajo.
N Q Figura 6.8.3
e Haga clic con el boton derecho
o del ratén en el mend contextual
(solamente durante el modo de
Hremgaict | disefio de las anotaciones de
Transparent Color... USU&I’iO)
Fill...

Undo
Cut

Copy
Paste

Delete
Select All

Bring to Front
Send to Back

Hide Rotate Handles for All Objects

Default Properties

Foreground Color...
Background Color...

Text Color...

MNote Background Color...
Redact Background Color...
Hilite Background Color...
Font...

Button Font...

Hotspot Metafile..,
Encrypt Metafile...
Decrypt Metafile...
Ruler...

Nodes...

Protractor...

Show Stamp Border
Point...

Encrypt...

Fixed...

Hyperlink...

Desde estos menus contextuales se pueden realizar muchas configuraciones especificas.

Nota: si un elemento parece demasiado pequefio para leerlo o verlo correctamente, usted lo
podra cambiar desde los menuUs contextuales del raton mostrados mas arriba. De forma
alternativa, podra elegir hacer zoom en la imagen utilizando la herramienta Dynamic Zoom
(Zoom dinamico). Esto ampliara la imagen y usted deberia poder ver claramente cualquier

anotacion.
Mostrar u ocultar las anotaciones
El boton Toggle Annotations (Alternar anotaciones), que se muestra en la Figura 6.8.4
Figura 6.8.4, permite a los usuarios activar y desactivar rapidamente las E Opcion Mostrar/Ocultar para
anotaciones. Por defecto, las anotaciones estaran activadas. El botdn se encuentra las anotaciones del usuario

en el menu del lado derecho, cerca de la esquina superior derecha.
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El menl «Help» (Ayuda), véase la Figura 6.9.1, se encuentra en la barra de menu superior y
permite un acceso rapido a «User’'s Manual» (Manual del usuario) y a «About Vision» (Acerca

de Vision) de Faxitron Core. Consulte la Figura 6.10.1.

Open User's Manual

About Vision

El submend «About Vision» (Acerca de Vision) abre un cuadro de didlogo que muestra la
version del software de Vision, la fecha, la propiedad intelectual y la informacion del sistema.

About Vision
Yision Yersion 3.1.4.Revl U (64-Bif)
Copyright (C) 2005-2018 Faxitron Bioptics LLC

——— Processing Library Information
Yersiond 3.0.3.1 MNarme: FBFProcessing.dil

——  Camera Library Information
Wersiond 3.0.11.1 MNarme: FBCamUSEB.dI

Configuration Utility Infarmation
“ersion# 1.2.1.1

——— Camera Information
Make: Bioptics Inc,  Serial# 03346
hModel: Digital Cassette 1M-2-30-40-E50-EM
Sensor type: BIOP_512x1024

—— ¥-Ray System Information
Make: BIOPTICS, hodel: COREVISION
Firmware Yersion# Cv002.02

>

6.9.0
Ayuda

Figura 6.9.1
MenU Ayuda

6.10.0

Acerca del
software Vision de
Faxitron

Figura 6.10.1

Cuadro de dialogo Informacion
sobre Vision de Faxitron
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3.0
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¢ N.° de documento cambiado de 1043C a
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de BioVision.

¢ Insercion de la nueva Seccion 2: la

proteccion radioldgica y los rayos X.

¢ Insercion de la nueva Seccion 3: Acerca de

BioVision.

¢ Revision importante del resto del documento.

Alan Mihalko

Akif Baysal

3.1

4 de
febrero de
2015

Imagenes actualizadas en todo el manual
para reflejar la paleta de colores actual de
Faxitron Core y el logotipo de la empresa.

Afadida la Tabla de historial de revisiones.

Paul Hess

Mikhail
Viznyuk

3.2

28 de julio
de 2015

Pag. 78 Correccion de los errores tipograficos
de la figura.

Pag. 81/82 Se ha borrado el texto repetido.

Pag. 86 Correccion de la ubicacion de la
referencia.

P&g. 88 Correccion de la referencia de la
figura.

Péag. 98 Se ha borrado el texto repetido.

Pag. 99 Correccion de la descripcion de
basqueda.

Pag. 103 Se ha borrado el texto repetido.
Pag. 109 Correccion de las referencias.

Paul Hess

Mikhail
Viznyuk

HOLOGIC

MANUAL DE USUARIO DE FAXITRON CORE | HOLOGIC | REVISION 042

7-1




Pag. 61 Correccion de la etiqueta de la

reorganizado la seccion.

= Se ha borrado material que no estuviese
directamente relacionado con el
funcionamiento basico del sistema.

e Seccibn 6: para que la progresion fuera mas
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= Se harevisado la secuencia de la puesta
en marcha

= Se harevisado la seccion sobre
calibracion de la caAmara

= Se ha cambiado el flujo de datos del
paciente
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C. Purdy
042 12-03-2019 | Se ha actualizado el branding Dhaval Saraiya D. Saraiya
R. Nash

M. Fremont
D. Canny
S. Howerton

T. Longo
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